Legal Notices
This guide is copyrighted ©2007 by Digidesign, a division of Avid Technology, Inc. (hereafter “Digidesign”), with all rights reserved. Under copyright laws, this guide may not be duplicated in whole or in part without the written consent of Digidesign.

003, 003 Rack, 96 I/O, 96i I/O, 192 Digital I/O, 192 1/0, 888|24 1/0, 882|20 1/0, 1622 I/O, 24-Bit ADAT Bridge I/O, AudioSuite, Avid, Avid DNA, Avid Mojo, Avid Unity, Avid Unity ISIS, Avid Unity MediaNetwork, Avid Xpress, A|option, A|option V10, Beat Detective, Bruno, Command|8, Control|24, D-Command, D-Control, D-Fi, D-Fx, D-Show, DAE, Digi 002, Digi 002 Rack, DigiBase, DigiDelivery, Digidesign, Digidesign Audio Engine, Digidesign Intelligent Noise Reduction, Digidesign TDM Bus, DigiDrive, DigiRack, DigiTest, DigiTranslator, D|NR, DV Toolkit, EditPack, Impact, Interplay, M-Audio, MachineControl, Maxim, Mbox, MediaComposer, MIDI I/O, MIX, MultiShell, OMFI, OMF Interchange, PRE, ProControl, Pro Tools M-Powered, Pro Tools, Pro Tools|HD, Pro Tools LE, QuickPunch, Reel Tape, Reso, Reverb One, Rev|rive, RTAS, Smack!, Sound|Replacer, Sound Designer II, Strike, Structure, SYNC HD, SYNC I/O, Synchronic, TL Space, Velvet, and X-Form are trademarks or registered trademarks of Digidesign and/or Avid Technology, Inc. All other trademarks are the property of their respective owners.

Product features, specifications, system requirements, and availability are subject to change without notice.

PN 9106-56822-00 REV A 7/07

Comments or suggestions regarding our documentation? email: techpubs@digidesign.com

DECLARATION OF CONFORMITY
We, Digidesign,
2001 Junipero Serra Blvd.
Daly City, California 94014-3886, USA
650-731-6100
declare under our sole responsibility that the product
HD Core, HD Process, or HD Accel complies with Part 15 of FCC Rules.
Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Communication Statement
NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try and correct the interference by one or more of the following measures:
• Reorient or locate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

Any modifications to the unit, unless expressly approved by Digidesign, could void the user’s authority to operate the equipment.
Canadian Compliance Statement:
This Class A digital apparatus complies with Canadian ICES-003
Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada

Australian Compliance

ACN: 069 650 120

European Compliance

Digidesign is authorized to apply the CE (Conformité Européenne) mark on this compliant equipment thereby declaring conformity to EMC Directive 89/336/EEC and Low Voltage Directive 73/23/EEC.
**Contents**

**Chapter 1. Welcome to Pro Tools|HD**
- Pro Tools|HD Systems ............................................................... 1
- Pro Tools|HD System Packages ............................................. 2
- Pro Tools HD Capabilities ................................................... 2
- Pro Tools Hardware Overview ................................................. 3
- System Requirements ........................................................... 8
- Digidesign Registration ......................................................... 9
- About the Pro Tools Guides .................................................. 9
- About www.digidesign.com .................................................. 10

**Chapter 2. Installing Pro Tools on Windows**
- Installation Overview ......................................................... 11
- Installing Pro Tools Hardware ............................................... 11
- Installing Pro Tools HD Software ........................................... 17
- Launching Pro Tools ............................................................. 18
- Additional Software on the Pro Tools Installer Disc .................. 19
- Uninstalling Pro Tools ......................................................... 20

**Chapter 3. Installing Pro Tools on Mac**
- Installation Overview .......................................................... 21
- Installing Pro Tools Hardware ................................................. 22
- Installing Pro Tools HD Software ............................................ 28
- Launching Pro Tools ............................................................. 29
- Additional Software on the Pro Tools Installer Disc .................. 29
- Uninstalling Pro Tools .......................................................... 31
Appendix D. Configuring AMS (Mac OS X Only) ........................................... 79
  Audio MIDI Setup ................................................................................. 79
  MIDI Patch Name Support ..................................................................... 82

Appendix E. DSP-Induced Delays in Mixing ............................................. 83
  Introduction to DSP-Induced Delay ..................................................... 83
  Automatically Compensating for Delays ............................................. 84
  Delay Factors ....................................................................................... 86

Appendix F. TDM Mixing and DSP Usage .................................................. 89
  Benefits of TDM II .............................................................................. 89
  DSP Allocation .................................................................................... 91
  DSP Usage and Mixer Plug-Ins .......................................................... 93
  DSP Usage with TDM Plug-Ins ........................................................... 99

Appendix G. Troubleshooting .................................................................. 101
  Backing Up Your Work ...................................................................... 101
  Common Issues .................................................................................. 102
  Using DigiTest as a Diagnostic Tool ................................................. 102
  Performance Factors .......................................................................... 103
  Before You Call Digidesign Technical Support .................................... 103

Index ...................................................................................................... 105
Welcome to Pro Tools|HD. Pro Tools|HD audio cards and interfaces bring high-definition digital audio recording, editing, signal processing, mixing, and I/O capabilities to Pro Tools.

This guide covers installation and configuration of Pro Tools|HD hardware and Pro Tools® software on Windows and Mac platforms.

**Pro Tools|HD Systems**

Pro Tools software supports the following systems:

**Pro Tools|HD (for PCIe) Systems**  
(Mac Only)

Pro Tools|HD (for PCIe) systems are available in the following configurations:

**Pro Tools|HD 1 (for PCIe)**
- Accel Core (for PCIe) card

**Pro Tools|HD 2 Accel (for PCIe)**
- Accel Core (for PCIe) card
- HD Accel (for PCIe) card

**Pro Tools|HD 3 Accel (for PCIe)**
- Accel Core (for PCIe) card
- Two HD Accel (for PCIe) cards

**Pro Tools|HD (for PCI) Systems**  
(Windows and Mac)

Pro Tools|HD (for PCI) systems are available in the following configurations:

**Pro Tools|HD 1 (for PCI)**
- HD Core (for PCI) card

**Pro Tools|HD 2 Accel (for PCI)**
- HD Core (for PCI) card
- HD Accel (for PCI) card

**Pro Tools|HD 3 Accel (for PCI)**
- HD Core (for PCI) card
- Two HD Accel (for PCI) cards

💡 Pro Tools also supports earlier Pro Tools|HD 2 (for PCI) and Pro Tools|HD 3 (for PCI) systems. These systems shipped with HD Pro- cess cards instead of HD Accel cards

❗ Pro Tools HD supports more than three HD cards in certain system configurations. For more information, see the Expanded Systems Guide.
Pro Tools|HD System Packages

All Pro Tools|HD systems include the following:

- Pro Tools|HD card(s)
- Pro Tools Installer disc containing Pro Tools software, DigiRack RTAS (Real-Time AudioSuite) and AudioSuite plug-ins, and electronic PDF guides
- Pre-authorized iLok for running Pro Tools HD
- This Getting Started Guide, covering installation and configuration of Pro Tools|HD systems
- Pro Tools Reference Guide and other documentation
- DigiLink cable for connecting the primary card to an audio interface
- TDM FlexCables (multi-card systems only) to connect the cards to each other
- Digidesign Registration Information Card

All Pro Tools|HD systems also require at least one Digidesign audio interface (sold separately). See “Audio Interfaces” on page 6.

Pro Tools HD Capabilities

Pro Tools HD on Windows or Mac provides the following capabilities:

- Up to a total of 256 audio tracks, 160 Auxiliary Input tracks, 64 Master Fader tracks, 128 VCA Master tracks, 256 MIDI tracks, 128 Instrument tracks, and 64 video tracks per session
- 16-bit or 24-bit audio resolution, at sample rates up to 192 kHz
- Non-destructive, random-access editing and mix automation
- Audio processing with up to 5 TDM or RTAS plug-ins per track, depending on your computer's capabilities
- Up to 5 hardware inserts per track
- Up to 10 sends per track
- Up to 128 internal busses for routing and mixing

The number of simultaneous tracks of audio recording or playback depends on the type of Pro Tools|HD system.
Audio Recording and Playback Capabilities

Pro Tools|HD 1 (for PCIe and PCI)
Pro Tools|HD 1 systems provide recording and playback of 24-bit or 16-bit audio files with the following track counts:
- Up to 96 tracks at 44.1 kHz or 48 kHz
- Up to 48 tracks at 88.2 kHz or 96 kHz
- Up to 18 tracks (for PCIe) or 12 tracks (for PCI) at 176.4 kHz or 192 kHz

Pro Tools|HD 2 Accel and HD 3 Accel (for PCIe and PCI)
Pro Tools|HD 2 Accel and HD 3 Accel systems provide recording and playback of 24-bit or 16-bit audio files with the following track counts:
- Up to 192 tracks at 44.1 kHz or 48 kHz
- Up to 96 tracks at 88.2 kHz or 96 kHz
- Up to 36 tracks at 176.4 kHz or 192 kHz

Non-HD Accel Systems (for PCI)
Pro Tools|HD 2 and HD 3 systems (original Pro Tools|HD systems with no HD Accel cards) provide recording and playback of 24-bit or 16-bit audio files with the following track counts:
- Up to 128 tracks at 44.1 kHz or 48 kHz
- Up to 64 tracks at 88.2 kHz or 96 kHz
- Up to 24 tracks at 176.4 kHz or 192 kHz

Pro Tools Hardware Overview
This section describes each hardware component of a Pro Tools|HD system. The number of Pro Tools|HD cards in your system will differ depending on your system configuration.

Pro Tools|HD (for PCIe) Hardware

Accel Core (for PCIe) Card
All Pro Tools|HD (for PCIe) systems include an Accel Core (for PCIe) card.

The Accel Core (for PCIe) card provides up to 96 tracks of direct-to-disk recording and playback, as well as DSP power for mixing and plug-in processing. The Accel Core (for PCIe) card supports up to 24-bit and up to 192 kHz sessions.

DigiLink Port The Accel Core (for PCIe) card includes a single DigiLink port for connecting up to 32 channels of audio input and output to your Pro Tools|HD system.

DigiSerial Port The DigiSerial port on the Accel Core (for PCIe) card is for connecting a Digidesign SYNC I/O. This connector is an 8-pin mini-DIN.

⚠ The DigiSerial port on an Accel Core (for PCIe) card does not support Machine-Control connections.
**HD Accel (for PCIe) Card**

The *HD Accel (for PCIe)* card is included in Pro Tools|HD 2 Accel (for PCIe) and Pro Tools|HD 3 Accel (for PCIe) systems. The HD Accel (for PCIe) card is an expansion card, and requires the presence of at least one Accel Core (for PCIe) card.

The HD Accel (for PCIe) card provides additional channels of direct-to-disk recording and playback, as well as additional DSP power for mixing and plug-in processing. The HD Accel (for PCIe) card supports sessions up to 24-bit and up to 192 kHz.

**DigiLink Port**

The HD Accel (for PCIe) card includes a single DigiLink port for connecting up to 32 channels of audio input and output to your Pro Tools|HD system.

**DigiSerial Port**

The DigiSerial port on the HD Accel (for PCIe) card does not offer any functionality.

---

**Pro Tools|HD (for PCI) Hardware**

**HD Core (for PCI) Card**

All Pro Tools|HD (for PCI) systems include an *HD Core (for PCI)* card.

The HD Core (for PCI) card provides up to 96 tracks of direct-to-disk recording and playback, as well as DSP power for mixing and plug-in processing. The HD Core (for PCI) card supports up to 24-bit and up to 192 kHz sessions.

**DigiLink Port**

The HD Core (for PCI) card includes a single DigiLink port for connecting up to 32 channels of audio input and output to your Pro Tools|HD system.

**DigiSerial Port**

The DigiSerial port on the HD Core (for PCI) card is for connecting a Digidesign SYNC I/O. This connector is an 8-pin mini-DIN.

⚠️ *The DigiSerial port on an HD Core (for PCI) card does not support MachineControl connections.*

⚠️ *If your HD Core (for PCI) card has two DigiSerial ports, use the DigiSerial port closest to the DigiLink connector.*
**HD Accel (for PCI) Card**

The **HD Accel (for PCI)** card is included in Pro Tools|HD 2 Accel (for PCI) and Pro Tools|HD 3 Accel (for PCI) systems. The HD Accel (for PCI) card is an expansion card, and requires the presence of at least one HD Core (for PCI) card.

The HD Accel (for PCI) card provides additional tracks of direct-to-disk recording and playback, as well as additional DSP power for mixing and plug-in processing. The HD Accel (for PCI) card supports sessions up to 24-bit and up to 192 kHz.

**DigiLink Port**

The HD Accel (for PCI) card includes a single DigiLink port for connecting up to 32 channels of audio input and output to your Pro Tools|HD system.

**DigiSerial Port**

The DigiSerial port on the HD Accel (for PCI) card does not offer any functionality.

---

**TDM FlexCable**

The TDM FlexCable is used to connect a pair of cards in your Pro Tools system so they can share data along the TDM bus. One FlexCable comes with each expansion card.

⚠️ *The TDM FlexCable is a flexible printed circuit board with delicate traces. Do not over-bend, twist, or pinch the cable. Doing so may cause unpredictable behavior in Pro Tools as well as harm to your system.*


Audio Interfaces

To record and play audio you must have at least one of the following Digidesign audio interfaces:

192 I/O Audio Interface

- Supports sample rates up to 192 kHz. (At least one 192 I/O™ or 192 Digital I/O must be connected to your Pro Tools|HD system for 192 kHz recording, processing, and playback.)

- Supports both analog and digital connections, including AES/EBU, S/PDIF, TDIF, and ADAT Optical:
  - Digital (Digital I/O Card): 8 channels, DB-25 (AES/EBU and TDIF), or one pair of Lightpipe (ADAT Optical) connectors. Expandable up to 16 channels digital I/O with the addition of the 192 Digital expansion card.
  - Analog: 8 channels, DB-25 (balanced) connectors, inputs selectable between +4 dBu or −10 dBV, outputs +4 dBu only. Expandable up to 16 analog inputs or 16 outputs using an optional 192 AD or 192 DA expansion card, respectively.
  - Digital (Enclosure): 2 channels, XLR (AES/EBU) connectors; 2 channels RCA (S/PDIF) connectors.
  - Optical (Enclosure): 8 channels, one pair of Lightpipe (ADAT Optical) connectors (switchable to 2 channels, S/PDIF).

- Loop Sync In and Out for connecting Pro Tools|HD interfaces and peripherals

- External Clock In and Out receive or send 1x Word clock (configurable to 256x for Legacy support, see “Optional Legacy I/O Audio Interfaces” on page 7).

192 Digital I/O Audio Interface

- Supports sample rates up to 192 kHz. (At least one 192 I/O or 192 Digital I/O must be connected to your Pro Tools|HD system for 192 kHz recording, processing, and playback.)

- Supports digital connections, including AES/EBU, S/PDIF, TDIF, and ADAT Optical:
  - Digital (2 Digital I/O Cards): 16 channels, DB-25 (AES/EBU and TDIF), or two pairs of Lightpipe (ADAT Optical) connectors.
  - Digital (Enclosure): 2 channels, XLR (AES/EBU) connectors; 2 channels RCA (S/PDIF) connectors.
  - Optical (Enclosure): 8 channels, one pair of Lightpipe (ADAT Optical) connectors (switchable to 2 channels, S/PDIF).

- Loop Sync In and Out for connecting Pro Tools|HD interfaces and peripherals

- External Clock In and Out receive or send 1x Word clock (configurable to 256x for Legacy support, see “Optional Legacy I/O Audio Interfaces” on page 7).
**96 I/O Audio Interface**

- Supports sample rates up to 96 kHz.
- Supports analog and digital connections, including AES/EBU, S/PDIF, and ADAT optical:
  - Analog: 8 channels, 1/4-inch TRS (balanced or unbalanced) connectors, +4 dBu or –10 dBV
  - Digital: 2 channels, XLR (AES/EBU) connectors; 2 channels, RCA (S/PDIF) connectors
  - Optical: 8 channels, one pair of Lightpipe (ADAT Optical) connectors (switchable to 2 channels, S/PDIF)
- External Clock In and Out receive or send 1x Word clock (configurable to 256x for Legacy support, see “Optional Legacy I/O Audio Interfaces” on page 7)

**96i I/O Audio Interface**

- Supports sample rates up to 96 kHz
- 16 discrete channels of input, and 2 channels of output, with 4-segment LED meters on each channel. Audio inputs and outputs include:
  - 16 channels of 24-bit, 96-kHz capable analog input, with adjustable input sensitivity
  - 2 channels of 24-bit, 96-kHz capable analog output, with selectable operating level
  - 2 channels of 24-bit, 96 kHz-capable digital S/PDIF RCA input and output
- Loop Sync In and Out for connecting Pro Tools|HD interfaces and peripherals
- External Clock In and Out receive or send 1x Word clock

**Optional Legacy I/O Audio Interfaces**

For additional input and output channels, older Digidesign audio interfaces (or Legacy I/Os) can be connected to the 192 I/O, 192 Digital I/O, or 96 I/O™ (the 96i I/O™ does not support Legacy interfaces). The following supported legacy interfaces can only be used with 44.1 kHz or 48 kHz sessions:

**888|24 I/O Audio Interface**

- Analog: 8 channels, XLR (balanced or unbalanced) connectors, selectable between +4 dBu or –10 dBV
- Digital: 8 channels, XLR (AES/EBU) connectors; 2 channels, RCA (S/PDIF) connectors

**882|20 I/O Audio Interface**

- Analog: 8 channels, 1/4-inch TRS (balanced or unbalanced) connectors, selectable between +4 dBu and –10 dBV
- Digital: 2 channels, RCA (S/PDIF) connectors

**1622 I/O Audio Interface**

- Analog: 16 input channels and 2 output channels, 1/4-inch TRS (balanced or unbalanced) connectors. Inputs are selectable from +4 dBu to –10 dBV line levels and higher in 2 dB gain steps; outputs are selectable between +4 dBu or –10 dBV.
- Digital: 2 channels, RCA (S/PDIF) connectors.

**Digidesign 24-bit ADAT Bridge I/O**

- Optical: 16 channels, a pair of Lightpipe (ADAT) connectors.
- Analog output: 2 channels, 1/4-inch TRS (balanced) connectors, selectable between +4 dBu and –10 dBV.
- Digital: 2 channels, XLR (AES/EBU); 2 channels RCA (S/PDIF) connectors.
System Requirements

Pro Tools|HD system hardware and supported audio interfaces can be used with a Digidesign-qualified Windows or Mac computer running Pro Tools HD software.

A DVD drive is required to use the Pro Tools Installer disc.

For complete system requirements, visit the Digidesign website (www.digidesign.com).

Compatibility Information

Digidesign can only assure compatibility and provide support for hardware and software it has tested and approved.

For a list of Digidesign-qualified computers, operating systems, hard drives, and third-party devices, refer to the Digidesign website (www.digidesign.com).

MIDI Requirements

USB MIDI interfaces work effectively with Pro Tools systems on Windows or Mac. Serial MIDI interfaces are supported on Windows systems only.

Only USB MIDI interfaces are compatible with Pro Tools systems on Mac OS X. Modem-to-serial port adapters and serial MIDI devices are not supported.

For a list of supported adapters, refer to the Digidesign website (www.digidesign.com).

Hard Drive Requirements

For optimal audio recording and playback, all Pro Tools|HD systems require one or more Digidesign-qualified drives.

For general hard drive maintenance and configuration information, see Appendix B, “Hard Drive Configuration and Maintenance.”

If you are using one or more SCSI drives, refer to Appendix A, “Connecting SCSI Drives.”

If you are using an ATA/IDE or FireWire hard drive, initialize your drive with Windows Disk Management (Windows) or the Disk Utility application included with Apple System software (Mac).

For more information, see Appendix B, “Hard Drive Configuration and Maintenance.”

Avoid Recording to the System Drive

Recording to your system drive is not recommended. Recording and playback on a system drive may result in lower track counts and fewer plug-ins.

Digidesign does not recommend recording to a system drive. Record to a system drive only when necessary.
Digidesign Registration

Review the enclosed Digidesign Registration Information Card and follow the instructions on it to quickly register your purchase online. This is one of the most important steps you can take as a new user. Registering your purchase is the only way you can be eligible to receive:

- Complimentary technical support
- An update to the latest version of Pro Tools at no charge if you bought a system with older software in the box
- Future upgrade offers.

About the Pro Tools Guides

In addition to any printed guides or documentation included with your system, PDF versions of Pro Tools guides and Read Mes are installed automatically during Pro Tools installation to the Digidesign/Documentation folder.

To view or print PDF guides, you can use Adobe Reader or Apple Preview (Mac only).

💡 Printed copies of the Pro Tools Reference Guide and other guides in the Pro Tools guide set can be purchased separately from the DigiStore (www.digidesign.com).

Guides Accessible in Pro Tools

The main Pro Tools guides are accessible from the Pro Tools Help menu. These include:


- **Pro Tools Menus Guide** covers all the Pro Tools on-screen menus.

- **DigiRack Plug-ins Guide** explains how to use Digidesign® plug-ins included with Pro Tools for both real-time and file-based audio processing.

- **Pro Tools Shortcuts** for your operating system, lists keyboard and Right-click shortcuts for Pro Tools, including those shown in Pro Tools menus.
Conventions Used in This Guide

Digidesign guides use the following conventions to indicate menu choices and key commands:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Save</td>
<td>Choose Save from the File menu</td>
</tr>
<tr>
<td>Control+N</td>
<td>Hold down the Control key and press the N key</td>
</tr>
<tr>
<td>Control-click</td>
<td>Hold down the Control key and click the mouse button</td>
</tr>
<tr>
<td>Right-click</td>
<td>Click with the right mouse button</td>
</tr>
</tbody>
</table>

The following symbols are used to highlight important information:

💡 **User Tips** are helpful hints for getting the most from your system.

⚠️ **Important Notices** include information that could affect your data or the performance of your system.

🖥️ **Shortcuts** show you useful keyboard or mouse shortcuts.

🔍 **Cross References** point to related sections in this guide and other Digidesign guides.

About www.digidesign.com

The Digidesign website (www.digidesign.com) is your best source for information to help you get the most out of your Pro Tools system. The following are just a few of the services and features available.

**Product Registration** Register your purchase online. See the enclosed Digidesign Registration Information Card for instructions.

**Support and Downloads** Contact Digidesign Technical Support or Customer Service; download software updates and the latest online manuals; browse the Compatibility documents for system requirements; search the online Answerbase; join the worldwide Pro Tools community on the Digidesign User Conference.

**Training and Education** Become a certified Pro Tools Operator or Expert; study on your own using courses available online, or find out how you can learn in a classroom setting at a certified Pro Tools Training Center.

**Products and Developers** Learn about Digidesign products; download demo software; learn about our Development Partners and their plug-ins, applications, and hardware.

**News and Events** Get the latest news from Digidesign; sign up for a Pro Tools demo.

To learn more about these and other resources available from Digidesign, visit the Digidesign website (www.digidesign.com).
Installing Pro Tools on Windows

This chapter contains information for Windows systems only. If you are installing Pro Tools on a Mac computer, see Chapter 3, “Installing Pro Tools on Mac.”

⚠️ Before installing this version of Pro Tools, refer to the Read Me information included on the Pro Tools Installer disc.

Installation Overview

Installation of a Pro Tools|HD system on a Windows computer includes the following steps:

1. “Installing Pro Tools Hardware” on page 11. This step includes:
   • Disabling Driver Signing warnings.
   • Installing and connecting Pro Tools|HD cards.
   • Connecting audio interfaces
4. Configuring your system for improved performance. (See Chapter 4, “Configuring Your Pro Tools System.”)
5. Chapter 5, “Making Studio Connections.”

Installing Pro Tools Hardware

Disabling Driver Signing Warnings

Before you install Pro Tools|HD cards, temporarily disable the Driver Signing warning option. This expedites and automates much of the installation process. If you do not temporarily disable this option, warning messages (that you are installing an unsigned driver) will appear for each DSP chip detected during software installation.

To disable the warning option:

1. Choose Start > Control Panel.
2. Double-click System.
3. Click the Hardware tab in the System Control Panel.
4. Click the Driver Signing button.
5. Select “Ignore—Install the software anyway and don’t ask for my approval.”
6. Click OK to close the Driver Signing Options window.
7. Click OK to close the System Properties window.
8. Turn the computer off.
Installing Pro Tools|HD Cards

This section shows how to install Pro Tools|HD cards into a Windows computer. To install cards into an expansion chassis, see the Expanded Systems Guide.

To install Pro Tools cards:

1. Turn off your computer and any peripherals. Leave your computer’s power cable plugged in so the computer is grounded.

2. Disconnect all cables attached to the computer (such as hard drives, displays, USB and FireWire devices) except for the power cable.

3. Open the computer case.

4. Remove the metal access port cover behind the slot you want to use by removing the screw and sliding the cover out from the access port.

5. Depending on your system, do one of the following:
   - Install the Accel Core (for PCIe) card in the first PCIe slot.
   - Install the HD Core (for PCI) card in the first PCI slot.

6. If you are installing additional Pro Tools cards (or other cards), skip to the next step. If you have no additional cards to install, do the following:
   - Secure the card in place with the slot access port screw you removed earlier.
   - Close the computer case.
   - Skip to “Connecting Audio Interfaces” on page 13.

7. Install the first HD Accel card (if any) in the second PCI slot.

8. Install any remaining HD Accel cards in the remaining consecutive PCI slots.

9. Install any HD Process cards in the remaining consecutive PCI slots (64-bit or 32-bit).

10. If you are installing a SCSI host bus adapter (HBA) card, install it in the highest-numbered remaining slot.

11. Check to be sure that your cards are installed in the proper order for your system, starting with the lowest numeric slot:
   - Display card for your computer monitor
   - Accel Core (for PCIe) or HD Core (for PCI) card
   - HD Accel cards
   - HD Process cards
   - SCSI host bus adapter (HBA) card

12. Secure each card in place with the slot access port screws you removed earlier.

Connecting Pro Tools|HD Cards

In systems that include more than one card, you must connect all the Pro Tools|HD cards to each other with TDM FlexCables.

Each Pro Tools|HD card has two ports along the top of the card, labeled Port A and Port B. The FlexCable has two connectors, also labeled Port A and Port B, to ensure proper connection. Data communication across multiple cards is achieved by connecting Port B of the first card to Port A of the next card with a TDM FlexCable.

- The first FlexCable always goes from Port B on the core card to Port A on the first expansion card, as described in the following steps.
To connect Pro Tools|HD cards:

1. Shape the FlexCable before installing it on the card by holding the cable with its printed side facing you, and moving the Port B portion of the cable straight towards you and inwards, as shown below. Do not bend the cable more than you need to, as you may damage the traces in the cable.

2. Slide the FlexCable into the notch of the first card, so that the Port B connector of the FlexCable can be aligned with Port B of the first card; and the Port A connector of the FlexCable can be aligned with Port A of the second card, as shown below.

3. Connect the Port A connector of the FlexCable to Port A on the second card. Push gently but firmly until the cable is fully connected to the card. Attach the other end of the FlexCable (labeled Port B) to Port B on the first card.

4. Verify the connection. Make sure the FlexCable ports seat flat against the sockets on the cards, and are firmly attached.

5. For systems with more than two cards, connect each additional card to its preceding card. Use FlexCables to connect card pairs together, as described above, until all cards are connected. (Each HD Accel or HD Process card is packaged with a FlexCable.)

6. Close the computer case.

Connecting Audio Interfaces

Each Pro Tools|HD audio interface supplies up to 16 channels of input and output to your system. Audio interfaces are connected directly to Pro Tools|HD cards, or through the Expansion ports on other Pro Tools|HD interfaces.

Each Pro Tools|HD card supports up to 32 channels. To get a full 32 channels of I/O from one card, you can connect, or daisy-chain, a second 16-channel Pro Tools|HD I/O to the first Pro Tools|HD I/O that is connected directly to the Pro Tools|HD card.

Pro Tools|HD supports up to a maximum of ten 192 I/Os, 192 Digital I/Os, or 96 I/Os. Up to five 96i I/Os can be used simultaneously.
For examples of connecting multiple I/Os, see Figure 1 and Figure 2 on page 15.

⚠ Pro Tools|HD audio interfaces need room at their sides to maintain proper air flow for cooling. Do not block the sides of the unit or disconnect the internal fan. If the units are rack-mounted in a case, remove the case lids or doors before operating the system. Failure to do so can result in the units overheating very quickly, which can permanently damage sensitive components.

Legacy I/Os can also be connected to Pro Tools|HD interfaces. See “Connecting an Additional 16 Channels of Audio with Legacy I/Os” on page 16.

To connect Pro Tools|HD audio interfaces:

1 If you are using a single 192 I/O, 192 Digital I/O, 96 I/O, or 96i I/O, connect its Primary Port to the Accel Core (for PCIe) or HD Core (for PCI) card with the DigiLink cable provided with the card. You must attach at least one 192 I/O, 192 Digital I/O, 96 I/O, or 96i I/O to your system in order for Pro Tools to launch.

⚠ If you have at least one 192 I/O or 192 Digital I/O in your system configuration, it must be connected to the Accel Core (for PCIe) or HD Core (for PCI) card as the primary interface.

2 Connect additional Pro Tools|HD audio interfaces to subsequent Digidesign audio cards, or daisy-chain the interfaces (by connecting the Primary Port of the secondary interface to the Expansion Port of the primary interface).

If you are connecting both 192 I/O (or 192 Digital I/O) and 96 I/O audio interfaces to your system, connect the 192 I/O (or 192 Digital I/O) to your Accel Core (for PCIe) or HD Core (for PCI) card, followed by any additional 192 I/O (or 192 Digital I/O) interfaces connected to subsequent cards. Then connect 96 I/O interfaces to subsequent cards, or to other interfaces, then connect 96i I/O interfaces.

You can also connect a single Pro Tools|HD interface to each Pro Tools|HD card in your system using the provided DigiLink cables. (However, there is no advantage to this configuration over daisy-chaining interfaces.)

Connecting Loop Sync

If you are using two or more Pro Tools|HD audio interfaces or a SYNC I/O peripheral, Loop Sync must be connected to maintain proper clock among the devices.

To make Loop Sync connections:

1 Connect the Loop Sync Out of each interface to the Loop Sync In of the next interface with the BNC cables included in your I/O packaging.

2 Connect the Loop Sync Out of the last interface to the Loop Sync In of the primary interface or SYNC I/O peripheral.

Connecting Legacy I/Os

If you are connecting a Digidesign Legacy I/O, continue with “Connecting an Additional 16 Channels of Audio with Legacy I/Os” on page 16.

⚠ The 96i I/O does not support Legacy I/O.
Chapter 2: Installing Pro Tools on Windows

Figure 1. Two 96 I/Os (32-channel system)

Figure 2. Three 96 I/Os (48-channel system)
Connecting an Additional 16 Channels of Audio with Legacy I/Os

Each 192 I/O, 192 Digital I/O, and 96 I/O can support 16 channels of audio to and from Digidesign Legacy I/Os. (The 96i I/O does not support Legacy I/Os.) Legacy I/Os include the 888|24 I/O™, 882|20 I/O™, 1622 I/O™, and the 24-bit ADAT Bridge I/O™.

To connect Digidesign Legacy I/Os:

1. Connect the “MIX card” end of the peripheral cable that came with your Legacy I/O (60-pin side) to the Legacy Port on the primary Pro Tools|HD audio interface. Connect the other end to the Computer Port on the Legacy I/O.

2. Do one of the following:
   • Connect any additional Legacy I/Os in the same manner, to Pro Tools|HD audio interfaces connected directly to HD cards.
   - or -
   • If you are using a Y cable (Legacy 16-channel peripheral cable adapter), connect this to the Legacy port first, then connect the audio interface peripheral cables to Port A and Port B of the Y cable.

3. To properly clock the Legacy I/O, connect the Ext. Clock output port on the Pro Tools|HD I/O to the Slave Clock IN on the Legacy I/O. The Legacy I/O will switch to Slave mode once the proper clock is outputting from the Pro Tools|HD I/O. Always use the Ext. Clock Out port of the same I/O to which the Legacy I/O is attached.

If you are using the Y cable to connect multiple MIX audio interfaces, you must also connect the Slave Clock Out of the first Legacy interface to the Slave Clock In of the second Legacy interface with the provided BNC cable. You cannot clock more than two MIX audio interfaces from a single Pro Tools|HD audio interface. If you have a third MIX audio interface, supply its 256x clock from the Pro Tools|HD I/O to which its 60-pin cable is attached (either your second audio interface, or directly to an HD Accel or HD Process card).

A \textit{The original 888 I/O and 882 I/O interfaces are not supported with Pro Tools|HD.}

To ensure the proper functioning of Legacy I/Os (such as an 888|24 I/O or 882|20 I/O), launch Pro Tools and initialize the Legacy I/Os in the Hardware Setup dialog before turning them on (See “Configuring Legacy I/Os” on page 50). Then quit Pro Tools and shut down your computer. When relaunching your Pro Tools system, turn on your Legacy I/Os first and allow them to finish booting before turning on your Pro Tools|HD audio interfaces, and then your computer.

A Before you turn on and configure your Legacy I/Os, turn down the volume of output devices. Very loud digital noise may be emitted before the Legacy I/O is initialized.
Installing Pro Tools HD Software

After your Pro Tools|HD hardware is installed and connected, you are ready to install Pro Tools software.

⚠️ Make sure you have disabled Driver Signing warnings before beginning software installation. This will reduce the number of warning messages you see during installation. See “Disabling Driver Signing Warnings” on page 11.

To install Pro Tools HD software:

1. If you have Media Station|PT or Media Station|V10 installed on your system, uninstall it before proceeding.

   ⚠️ For details on uninstalling Media Station|PT or Media Station|V10, see the Avid Video Peripherals Guide.

2. Start Windows, logging in with Administrator privileges. For details on Administrator privileges, refer to your Windows documentation.


4. Insert the Pro Tools Installer disc in your CD/DVD drive.

5. On the Installer disc, locate and open the Pro Tools Installer folder.

6. Double-click the Setup icon.

7. Follow the on-screen instructions to proceed with installation.

8. Select the install location. For maximum reliability, install Pro Tools on your startup drive.

9. Click Next.

10. Select the Pro Tools application for installation.

11. You can also select from a list of optional items to install along with Pro Tools.

Mac HFS+ Disk Support Option This option lets your Pro Tools system read, write, record, and play back using Mac-formatted HFS+ disks. HFS+ disks are commonly referred to as Mac OS Extended disks.

Avid Video Engine The Avid Video Engine is required to use Pro Tools with Avid video peripherals such as the Avid Mojo or the Digidesign AVoption|V10.

DigiTranslator DigiTranslator™ is a software option for Pro Tools that lets you convert and exchange OMF and AAF sequences and MXF files directly in the Pro Tools application. This option is purchased separately.

MachineControl Digidesign MachineControl™ is a software option that lets you control external audio/video devices from Pro Tools using serial 9-pin protocols. This option is purchased separately.

Command|8 Controller and Driver The Command|8 Driver is required if you are using the Digidesign Command|8 control surface.

MP3 Export Option The MP3 Export Option lets you export MP3 files from Pro Tools. This option is purchased separately.

The Pro Tools Installer disc includes additional software for your system. For more information, see “Additional Software on the Pro Tools Installer Disc” on page 19.

12. Click Next.
13 Select your work environment. This loads an initial set of Pro Tools Preferences that include some of the more popular settings for post production, audio, or audio with MIDI.

Preference settings can be customized at any time in Pro Tools. See the Pro Tools Reference Guide for more information.

14 Click Next.

15 Select whether to install the Surround Mixer plug-in. This plug-in is required for mixing, mastering, and monitoring in surround.

- Select “Yes – Monitor in Pro Tools Film Format” if your monitoring is configured for Film Format surround.
- Select “Yes – Monitor in ProControl (DTS Format)” if you are using a ProControl dedicated controller.
- Select “No – Stereo mixing only” if your monitoring is configured for Stereo.

AFL/PFL Solo modes require the Surround Mixer plug-in. See the Pro Tools Reference Guide for more information.

16 Click Next.

17 Click Install.

Several messages are displayed during installation that can be ignored, including multiple “Found New Hardware” dialogs and “A Problem Occurred During Hardware Installation.”

Additionally, if you get a warning dialog about the driver not passing Windows Logo testing, click Continue Anyway.

18 Wait for the installer to finish installing all software components, drivers, and PACE System files before proceeding to the next step.

19 When installation is complete, click Finish.

Installing QuickTime

QuickTime is required for Pro Tools if you plan to include movie files, or import MP3 or MP4 (AAC) files in your sessions. QuickTime for Windows is available as a free download from the Apple website.

For information on which version of QuickTime is compatible with your version of Pro Tools, visit the compatibility pages of the Digidesign website (www.digidesign.com).

To install QuickTime:

1 Visit www.apple.com and download the QuickTime for Windows installer application to your computer.

2 Double-click the QuickTime installer application and follow the on-screen installation instructions.

3 Restart your computer.

If you turned off Driver Signing Warning on your computer, be sure to enable it once Pro Tools hardware and software have been installed.

Launching Pro Tools

To use Pro Tools HD, you must always have an inserted iLok with an authorization for Pro Tools HD. One pre-authorized iLok is included with your Pro Tools HD system.

To authorize Pro Tools HD software:

1 Make sure HD hardware is connected to your computer.

2 Insert the pre-authorized iLok into an available USB port on your computer.
3 Do one of the following:
   • Double-click the Pro Tools HD shortcut on the desktop.
   – or –
   • Locate and double-click the Pro Tools HD application on your hard drive.

⚠️ Do not remove the iLok during Pro Tools launch or use.

Additional Software on the Pro Tools Installer Disc

The Pro Tools Installer disc provides additional software for your system, including audio drivers (for playing other audio applications through your Digidesign hardware) and a Pro Tools demo session.

💡 Refer to your Pro Tools Installer disc for additional software and installers.

Windows Audio Drivers

The Digidesign ASIO Driver and WaveDriver Windows System Audio Driver let you use your Digidesign hardware interface with third-party applications that support the ASIO Driver or WaveDriver MME (Multimedia Extension).

The Digidesign ASIO Driver and WaveDriver for your Digidesign hardware are automatically installed when you install Pro Tools.

Digidesign ASIO Driver

The Digidesign ASIO (Audio Sound Input Output) Driver is a single-client multichannel sound driver that allows third-party audio programs that support the ASIO standard to record and play back through Digidesign hardware.

⚠️ For detailed information on configuring the Digidesign ASIO Driver, see the Windows Audio Drivers Guide.

Digidesign WaveDriver

(Windows XP Only)

The Digidesign WaveDriver Windows System Audio Driver is a single-client, stereo sound driver that allows third-party audio programs that support the WaveDriver MME (Multimedia Extension) standard to play back through Digidesign hardware.

⚠️ For detailed information on configuring the Digidesign WaveDriver, see the Windows Audio Drivers Guide.

Standalone Windows Audio Drivers

Digidesign Windows Audio Drivers can be installed on Windows systems that do not have Pro Tools software installed. Use the standalone version of the Digidesign Windows Audio Drivers installer (Digidesign Audio Drivers Setup.exe), which is available on the Pro Tools Installer disc.

⚠️ For information on installing and configuring the standalone version of the Digidesign Windows Audio Drivers, see the Windows Audio Drivers Guide.
Pro Tools Demo Session

The Pro Tools HD Installer disc includes a demo session that you can use to verify that your system is working.

The demo session for Pro Tool HD is named Meant To Be.

⚠️ Before installing the demo session to your audio drive, make sure the drive is configured as described in “Formatting an Audio Drive” on page 70.

To install the demo session:
1. Insert the Pro Tools HD Installer disc into your DVD drive.
2. From your DVD drive, locate and open the Additional Files/HD Demo Session Installer folder.
4. Follow the onscreen instructions.
5. When prompted, select your audio drive as the install location and click Next to begin the install.
6. When installation is complete, click Finish.

The demo session can be opened by double-clicking the Meant To Be.ptf file (located in the Meant To Be Demo Session folder).

Pro Tools Session Templates

The Pro Tools HD Installer disc includes factory session templates that are pre-configured to common track and mixer setups. Using these templates will save you the trouble of having to create your studio setup from scratch every time you start a new session.

See the Pro Tools Reference Guide for information on using or customizing session templates.

To install factory session templates:
1. Insert the Pro Tools Installer disc into your DVD drive.
2. From your DVD drive, locate and open the Additional Files/HD Session Templates Installer folder.
4. Follow the onscreen instructions.
5. When prompted, select your audio drive as the install location and click Next to begin the install.
6. When installation is complete, click Finish.

Uninstalling Pro Tools

If you need to uninstall Pro Tools software from your computer, you can use Windows commands for uninstalling programs.

To uninstall Pro Tools from your computer:
1. Choose Start > Control Panel.
2. Double-click Add or Remove Programs.
3. From the Currently Installed Programs list, select Digidesign Pro Tools.
4. Click the Remove button.
5. Follow the on-screen instructions to remove Pro Tools.
chapter 3

Installing Pro Tools on Mac

This chapter contains information for Mac systems only. If you are installing Pro Tools on a Windows computer, see Chapter 2, “Installing Pro Tools on Windows.”

⚠️ Before installing this version of Pro Tools, refer to the Read Me information included on the Pro Tools Installer disc.

Installation Overview

Installation of a Pro Tools|HD system on a Mac includes the following steps:

1 “Installing Pro Tools Hardware” on page 22. This step includes:
   • Installing and connecting Pro Tools|HD cards.
   • Connecting audio interfaces
3 “Launching Pro Tools” on page 29.
4 Configuring your system for improved performance. (See Chapter 4, “Configuring Your Pro Tools System.”)
5 Chapter 5, “Making Studio Connections.”
Installing Pro Tools Hardware

To install Pro Tools|HD hardware, you first install Pro Tools|HD cards, then for systems with more than one card, connect the cards with a TDM FlexCable.

Installing Pro Tools|HD Cards

This section shows how to install Pro Tools|HD cards into a Mac computer. To install cards into an expansion chassis, see the Expanded Systems Guide.

To install Pro Tools cards:

1. Turn off your computer and any peripherals. Leave your computer’s power cable plugged in so the computer is grounded.

2. Disconnect all cables attached to the computer (such as hard drives, displays, USB and FireWire devices) except for the power cable.

3. Open the computer case.

4. Remove the metal access port cover behind the slot you want to use by removing the screw and sliding the cover out from the access port.

5. Install the Accel Core (for PCIe) or HD Core (for PCI) card into the lowest-numbered slot in the computer. This will be the slot closest to the graphics card, as shown in the following examples:

### Mac Pro and Power Mac G5 (PCI Express)

The PCI Express-equipped Mac Pro and Power Mac G5 have three PCI Express (PCIe) slots (named slots 2, 3, and 4). The PCI Express slot numbers increase from bottom to top as you face the open computer case from the side. Install the Accel Core (for PCIe) card into PCI slot 2.

---

Before handling any card, discharge static electricity from your clothes or body by touching a grounded metal surface, such as the power supply case inside your computer.
**Power Mac G5 (PCI)** The PCI-equipped Power Mac G5 has three PCI slots (named PCI slot 2, 3, and 4). Slot numbers increase from bottom to top as you face the open computer case from the side. Install the HD Core (for PCI) card into PCI slot 2.

6 Install the first expansion card (if any) in the second slot (slot 3).

7 On Mac Pros, if you are installing a card into slot 4, do the following:
   - Remove all SATA drive trays from the Mac Pro.
   - Move the card into the area where the SATA trays were.
   - Place the rear of the card first into the slot at the back of the PCIe slots.
   - Maneuver the front of the card up and around; line it up with the PCIe slot and seat it.
   - Replace the SATA drives.

8 If you are installing a SCSI host bus adapter (HBA) card, install it in the highest-numbered remaining slot.

9 Check to be sure that your cards are installed in the proper order for your system, starting with the lowest numeric slot:
   - Pro Tools|HD (for PCIe) Systems
   - Display card for your computer monitor
   - Accel Core (for PCIe) card
   - HD Accel (for PCIe) cards
   - Digidesign-approved video capture card
   - SCSI host bus adapter (HBA) card

10 Secure each card in place with the slot access port screws you removed earlier.

**Connecting Pro Tools|HD Cards**

In systems that include more than one card, you must connect all the Pro Tools|HD cards to each other with TDM FlexCables.

Each Pro Tools|HD card has two ports along the top of the card, labeled Port A and Port B. The FlexCable has two connectors, also labeled Port A and Port B, to ensure proper connection. Data communication across multiple cards is achieved by connecting Port B of the first card to Port A of the next card with a TDM FlexCable.

**The first FlexCable always goes from Port B on the core card to Port A on the first expansion card, as described in the following steps.**
The slot numbering in your computer determines whether you will be working right-to-left or left-to-right when connecting cards. Refer to the instructions below for your model of computer.

**To connect Pro Tools|HD cards:**

1. **Shape the FlexCable before installing it on the card by holding the cable with its printed side facing you, and moving the Port B portion of the cable straight towards you and inwards, as shown below. Do not bend the cable more than you need to, as you may damage the traces in the cable.**

2. **Slide the FlexCable into the notch of the first card, so that the Port B connector of the FlexCable can be aligned with Port B of the first card; and the Port A connector of the FlexCable can be aligned with Port A of the second card, as shown below.**

3. **Connect the Port A connector of the FlexCable to Port A on the second card. Push gently but firmly until the cable is fully connected to the card. Attach the other end of the FlexCable (labeled Port B) to Port B on the first card.**

4. **Verify the connection. Make sure the FlexCable ports seat flat against the sockets on the cards, and are firmly attached.**

5. **For systems with more than two cards, connect each additional card to its preceding card. Use FlexCables to connect card pairs together, as described above, until all cards are connected. (Each expansion card is packaged with a FlexCable.)**

6. **Close the computer case.**

**Connecting Audio Interfaces**

Each Pro Tools|HD audio interface (except the 96i I/O) supplies up to 16 channels of input and output to your system. Audio interfaces are connected directly to Pro Tools|HD cards, or through the Expansion ports on other Pro Tools|HD interfaces.

Each Pro Tools|HD card supports up to 32 channels. To get a full 32 channels of I/O from one card, you can connect, or *daisy-chain*, a second 16-channel Pro Tools|HD I/O to the first 16-channel Pro Tools|HD I/O that is connected directly to the Pro Tools|HD card.

Pro Tools|HD supports up to a maximum of ten 192 I/Os, 192 Digital I/Os, or 96 I/Os. Up to five 96i I/Os can be used simultaneously.
For examples of connecting multiple I/Os, see Figure 3 and Figure 4 on page 26.

⚠️ Pro Tools|HD audio interfaces need room at their sides to maintain proper air flow for cooling. Do not block the sides of the unit or disconnect the internal fan. If the units are rack-mounted in a case, remove the case lids or doors before operating the system. Failure to do so can result in the units overheating very quickly, which can permanently damage sensitive components.

Legacy I/Os can also be connected to Pro Tools|HD interfaces. See “Connecting an Additional 16 Channels of Audio with Legacy I/Os” on page 27.

**To connect Pro Tools|HD audio interfaces:**

1. If you are using a single 192 I/O, 192 Digital I/O, 96 I/O, or 96i I/O, connect its Primary Port to the Accel Core (for PCIe) or HD Core (for PCI) card with the DigiLink cable provided with the card. You must attach at least one 192 I/O, 192 Digital I/O, 96 I/O, or 96i I/O to your system in order for Pro Tools to launch.

2. Connect additional Pro Tools|HD audio interfaces to subsequent Digidesign audio cards, or daisy-chain the interfaces (by connecting the Primary Port of the secondary interface to the Expansion Port of the primary interface).

   ⚠️ If you have at least one 192 I/O or 192 Digital I/O in your system configuration, it must be connected to the Accel Core (for PCIe) or HD Core (for PCI) card as the primary interface.

3. Connect additional Pro Tools|HD audio interfaces to subsequent Digidesign audio cards, or daisy-chain the interfaces (by connecting the Primary Port of the secondary interface to the Expansion Port of the primary interface).

If you are connecting both 192 I/O (or 192 Digital I/O) and 96 I/O audio interfaces to your system, connect the 192 I/O (or 192 Digital I/O) to your Accel Core (for PCIe) or HD Core (for PCI) card, followed by any additional 192 I/O (or 192 Digital I/O) interfaces connected to subsequent cards. Then connect 96 I/O interfaces to subsequent cards, or to other interfaces, then connect 96i I/O interfaces.

You can also connect a single Pro Tools|HD interface to each Pro Tools|HD card in your system using the provided DigiLink cables. (However, there is no advantage to this configuration over daisy-chaining interfaces.)

**Connecting Loop Sync**

If you are using two or more Pro Tools|HD audio interfaces or a SYNC I/O peripheral, Loop Sync must be connected to maintain proper clock among the devices.

**To make Loop Sync connections:**

1. Connect the Loop Sync Out of each interface to the Loop Sync In of the next interface with the BNC cables included in your I/O packaging.

2. Connect the Loop Sync Out of the last interface to the Loop Sync In of the primary interface or SYNC I/O peripheral.

**Connecting Legacy I/Os**

If you are connecting a Digidesign Legacy I/O, continue with “Connecting an Additional 16 Channels of Audio with Legacy I/Os” on page 27.

⚠️ The 96i I/O does not support Legacy I/O.
Figure 3. Two 96 I/Os (32-channel system)

Figure 4. Three 96 I/Os (48-channel system)
Connecting an Additional 16 Channels of Audio with Legacy I/Os

Each 192 I/O, 192 Digital I/O, and 96 I/O can support 16 channels of audio to and from Digidesign Legacy I/Os. (The 96i I/O does not support Legacy I/O.) Legacy I/Os include the 888|24 I/O, 882|20 I/O, 1622 I/O, and the 24-bit ADAT Bridge I/O.

⚠️ The original 888 I/O and 882 I/O interfaces are not supported with Pro Tools|HD.

To connect Digidesign Legacy I/Os:

1. Connect the “MIX card” end of the peripheral cable that came with your Legacy I/O (60-pin side) to the Legacy Port on the primary Pro Tools|HD audio interface. Connect the other end to the Computer Port on the Legacy I/O.

2. Do one of the following:
   - Connect any additional Legacy I/Os in the same manner, to Pro Tools|HD audio interfaces connected directly to Pro Tools|HD cards.
   - or –
   - If you are using a Y cable (Legacy 16-channel peripheral cable adapter), connect this to the Legacy port first, then connect the audio interface peripheral cables to Port A and Port B of the Y cable.

3. To properly clock the Legacy I/O, connect the Ext. Clock output port on the Pro Tools|HD I/O to the Slave Clock IN on the Legacy I/O. The Legacy I/O will switch to Slave mode once the proper clock is outputting from the Pro Tools|HD I/O. Always use the Ext. Clock Out port of the same I/O to which the Legacy I/O is attached.

If you are using the Y cable to connect multiple MIX audio interfaces, you must also connect the Slave Clock Out of the first Legacy interface to the Slave Clock In of the second Legacy interface with the provided BNC cable. You cannot clock more than two MIX audio interfaces from a single Pro Tools|HD audio interface. If you have a third MIX audio interface, supply its 256x clock from the Pro Tools|HD I/O to which its 60-pin cable is attached (either your second audio interface, or directly to an HD Accel or HD Process card).

⚠️ To ensure the proper functioning of Legacy I/Os (such as an 888|24 I/O or 882|20 I/O), launch Pro Tools and initialize the Legacy I/Os in the Hardware Setup dialog before turning them on (See “Configuring Legacy I/Os” on page 50). Then quit Pro Tools and shut down your computer. When relaunching your Pro Tools system, turn on your Legacy I/Os first and allow them to complete booting before turning on your Pro Tools|HD audio interfaces, and then your computer.

⚠️ Before you turn on and configure your Legacy I/Os, turn down the volume of output devices. Very loud digital noise may be emitted before the Legacy I/O is initialized.
Installing Pro Tools HD Software

After your Pro Tools HD hardware is installed and connected, you are ready to install Pro Tools software.

⚠️ Do not install or operate Pro Tools while logged in as a root-level user. File permissions of a root-level user make it possible to perform actions that may conflict with Pro Tools file management tasks.

To install Pro Tools HD software:

1. Make sure you are logged in as an Administrator for the account where you want to install Pro Tools. For details on Administrator privileges in Mac OS X, refer to your Apple OS X documentation.

2. Insert the Pro Tools Installer disc in your CD/DVD drive.

3. On the Installer disc, locate and double-click “Install Pro Tools.”

4. Follow the on-screen instructions to proceed with installation.

5. Select the install location. For maximum reliability, install Pro Tools on your startup drive.

6. Click Continue.

7. Select the Pro Tools application for installation.

8. You can also select from a list of optional items to install along with Pro Tools:

   **Avid Video Engine** The Avid Video Engine is required to use Pro Tools with Avid video peripherals such as the Avid Mojo or the Digidesign AVoption|V10.

   **DigiTranslator** DigiTranslator™ is a software option for Pro Tools that lets you convert and exchange OMF and AAF sequences and MXF files directly in the Pro Tools application. This option is purchased separately.

   **MachineControl** Digidesign MachineControl™ is a software option that lets you control external audio/video devices from Pro Tools using serial 9-pin protocols. This option is purchased separately.

   **MIDI I/O Driver** The MIDI I/O Driver is required if you are using the Digidesign MIDI I/O interface.

   **MP3 Export Option** The MP3 Export Option lets you export MP3 files from Pro Tools. This option is purchased separately.

9. Click Install.

10. If prompted, enter your Administrator password and click OK to accept the installation.

11. Select your work environment. This loads an initial set of Pro Tools Preferences that include some of the more popular settings for post production, audio, or audio with MIDI.

   Preference settings can be customized at any time in Pro Tools. See the Pro Tools Reference Guide for more information.

The Pro Tools Installer disc includes additional software for your system. For more information, see “Additional Software on the Pro Tools Installer Disc” on page 29.
12 Select whether to install the Surround Mixer plug-in. This plug-in is required for mixing, mastering, and monitoring in surround:

- Select “Yes – Monitoring in Standard Pro Tools (Film Format)” if your monitoring is configured for Film Format surround.
- Select “Yes – Monitoring in ProControl (DTS Format)” if you are using a ProControl dedicated controller.
- Select “No – Stereo mixing only” if your monitoring is configured for Stereo.

⚠️ AFL/PFL Solo modes require the Surround Mixer plug-in. See the Pro Tools Reference Guide for more information.

13 Click Continue.

14 When installation is complete, click Restart.

---

### Launching Pro Tools

To use Pro Tools HD, you must always have an inserted iLok with an authorization for Pro Tools HD. One pre-authorized iLok is included with your Pro Tools HD system.

**To authorize Pro Tools HD software:**

1. Make sure HD hardware is connected to your computer system.
2. Insert the pre-authorized iLok into an available USB port on your computer.
3. Do one of the following:
   - Click the Pro Tools HD icon in the Dock.
   - or –
   - Locate and double-click the Pro Tools HD application on your hard drive.

⚠️ Do not remove the iLok during Pro Tools launch or use.

---

### Additional Software on the Pro Tools Installer Disc

The Pro Tools Installer disc provides additional software for your system, including audio drivers (for playing other audio applications through your Digidesign hardware) and a Pro Tools demo session.

⚠️ Check your Pro Tools Installer disc for additional software and installers.

### Digidesign CoreAudio Driver

The Digidesign CoreAudio Driver is a multi-client, multichannel sound driver that allows CoreAudio-compatible applications to record and play back through Digidesign hardware.

The CoreAudio Driver is installed by default when you install Pro Tools.

⚠️ For information on configuring the Digidesign CoreAudio Driver, see the Digidesign CoreAudio Guide.

### Standalone CoreAudio Driver

The Digidesign CoreAudio Driver can be installed as a standalone driver on Mac systems that do not have Pro Tools software installed. The standalone version of this driver is available on the Pro Tools Installer disc (in the Additional Files Folder).

⚠️ If Pro Tools was uninstalled, CoreAudio Driver was automatically uninstalled at that time.

⚠️ For information on installing and configuring the standalone version of the Digidesign CoreAudio Driver, see the CoreAudio Drivers Guide.
**Pro Tools Demo Session**

The Pro Tools HD Installer disc includes a demo session that you can use to verify that your system is working.

The demo session for Pro Tool HD is named Meant To Be.

⚠ **Before installing the demo session to your audio drive, make sure the drive is configured as described in “Formatting an Audio Drive” on page 70.**

**To install the demo session:**

1. Insert the Pro Tools HD Installer disc into your DVD drive.
2. From your DVD drive, locate and open the Additional Files/HD Demo Session Installer folder.
4. Follow the onscreen instructions.
5. When prompted, select your audio drive as the install location and click Next to begin the install.
6. When installation is complete, click Close.

**Pro Tools Session Templates**

The Pro Tools HD Installer disc includes factory session templates that are pre-configured to common track and mixer setups. Using these templates will save you the trouble of having to create your studio setup from scratch every time you start a new session.

See the Pro Tools Reference Guide for information on using or customizing session templates.

**To install factory session templates:**

1. Insert the Pro Tools Installer disc into your DVD drive.
2. From your DVD drive, locate and open the Additional Files/HD Session Templates Installer folder.
4. Follow the onscreen instructions.
5. When prompted, select your audio drive as the install location and click Next to begin the install.
6. When installation is complete, click Close.

⚠ **The demo session can be opened by double-clicking the Meant To Be.ptf file (located in the Meant To Be Demo Session folder).**
Uninstalling Pro Tools

If you need to uninstall Pro Tools software from your computer, use the Uninstaller application.

To remove Pro Tools from your computer:

1. Make sure you are logged in as an Administrator for the account where Pro Tools is installed.

   For details on Administrator privileges in Mac OS X, refer to your Apple OS X documentation.

2. Go to Applications/Digidesign/Pro Tools/Pro Tools Utilities and double-click the “Uninstall Pro Tools” file.

3. Click Continue to proceed with the uninstall.

4. Choose the type of uninstall you want to perform:

   Safe Uninstall Leaves certain plug-ins and system files needed for compatibility with some Avid products.

   Clean Uninstall Removes all Pro Tools files, including system files, Digidesign plug-ins, and MIDI patch names.

5. Click Uninstall.

6. Enter your Administrator password and click OK.

7. Click Finish to close the Installer window.
After you have connected your system and installed Pro Tools software, you are ready to start up and configure your Pro Tools system.

**Starting Up or Shutting Down Your System**

Whenever you start your system, turn on all of your system components in a specific order.

**Start up your Pro Tools system in this order:**

1. Make sure all your equipment (including your computer) is off.
2. Lower the volume of all output devices in your system.
3. For Pro Tools|HD systems with an expansion chassis, turn on the expansion chassis.
4. Turn on any external hard drives. Wait approximately ten seconds for them to spin up to speed.
5. Turn on any control surfaces (such as Command|8) or worksurfaces (such as D-Command).
6. Turn on any MIDI interfaces and devices, or synchronization peripherals.
7. With the volume of all output devices lowered, turn on any Pro Tools Legacy I/Os (such as an 888|24 I/O or 882|20 I/O). Wait at least fifteen seconds for the audio interface to initialize and the status LEDs to stop flashing.
8. With the volume of all output devices lowered, turn on your Pro Tools|HD audio interfaces. Wait at least fifteen seconds for the audio interface to initialize and the status LEDs to stop flashing.
9. Turn on your computer.
10. Launch Pro Tools or any third-party audio or MIDI applications.

**Shut down your Pro Tools system in this order:**

1. Quit Pro Tools and any other running applications.
2. Turn off or lower the volume of all output devices in your system.
3. Turn off your computer.
4. Turn off your Pro Tools audio interfaces.
5. For Pro Tools|HD systems with an expansion chassis, turn off the chassis.
6. Turn off any MIDI interfaces, MIDI devices, or synchronization peripherals.

*To quit Pro Tools, choose File > Exit (Windows) or Pro Tools > Quit (Mac).*
7 Turn off any control surfaces or worksurfaces.
8 Turn off any external hard drives.

### Checking the System

Before you use Pro Tools, you may want to run the DigiTest diagnostic application to ensure that all Pro Tools|HD cards in the system are recognized, installed in the proper order, and have valid TDM FlexCable connections.

### Running DigiTest

DigiTest is installed with Pro Tools and resides in the following folder on your hard drive: Digidesign/Pro Tools/Pro Tools Utilities.

⚠️ Before you run DigiTest, lower the volume of all output devices. Very loud digital noise may be emitted during the test.

**To run DigiTest:**

1. Quit Pro Tools if it is running.
2. Lower the volume of all output devices on your system.
3. Locate and double-click the DigiTest icon on your hard drive.

DigiTest opens and lists the supported cards it finds in your system, showing their corresponding slot locations.

If you have a large number of cards or audio interfaces, it may take a while for the DigiTest window to appear, as DigiTest scans for all cards and interfaces connected to the system.

💡 The order in which cards are listed within DigiTest may not match the actual slot locations of cards installed in your computer or expansion chassis. This is normal, and does not affect DigiTest operations in any way.

4. Select the cards in your system you want to test by selecting Test in the left hand column for each card.
5. Click Run.

If cards are not installed in the proper order, DigiTest will display error codes in the Status box of each card identified as being misconfigured.

The more cards and audio interfaces in your system, the longer the test will take.
6 When prompted, power cycle all Pro Tools peripherals in your system. Click Continue.

7 To test the interfaces connected to your system, check “Test I/O Box.”

💡 LEDs on your digital interfaces may light up during this test. This is normal.

8 When the test is finished, you can view the test results by doing one of the following:
   • Click the Get Results button next to a card name.
   • Click the Results tab and choose a card slot from the pop-up menu.

9 In the Results page of the DigiTest window, click Show Failures Only to display failed tests for the selected card, or click Show All Results to display all test results for the selected card.

💡 For descriptions of error codes, refer to “DigiTest Error Codes” on page 35

10 Click Quit to close DigiTest.

11 Restart your computer.

Errors and Undetected Cards

Complete the steps below if any of the following occur:

- DigiTest fails to launch.
- An error message has been displayed for a card in DigiTest.
- A supported card is installed but not automatically detected during DigiTest.

If a supported card is installed and is not automatically detected:

1 Quit DigiTest.

2 Turn off the entire Pro Tools system.

3 Reinstall the Pro Tools|HD cards.

4 Check the card seating.

5 Check the TDM FlexCable connections. Check the orientation of the cable from card to card (ports B to A), and check the integrity of the FlexCable connections to the cards.

6 Turn on the system.

7 Run DigiTest again.

DigiTest Error Codes

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Err3</td>
<td>Cards from different Pro Tools systems are incorrectly mixed. See the configuration chapters.</td>
</tr>
<tr>
<td>Err4</td>
<td>Cards marked with this error are installed in the wrong order. See the configuration chapters.</td>
</tr>
<tr>
<td>Err5</td>
<td>Too many cards of this type are installed in the system. Refer to the Digidesign website for compatibility information.</td>
</tr>
<tr>
<td>Err6</td>
<td>A card is installed in a reserve slot. For example, a Digidesign card is installed in the slot reserved for the Expansion Chassis Host Interface card. Refer to the configuration chapters, as well as related installation guides.</td>
</tr>
<tr>
<td>Err1220</td>
<td>SCSI Accelerator card is installed in the wrong slot. See the configuration chapters for correct location of the card.</td>
</tr>
<tr>
<td>Err1221</td>
<td>Expansion Chassis Host Interface card is installed in the wrong slot. See Expanded Systems Guide for correct location of the card.</td>
</tr>
</tbody>
</table>
Identifying Digidesign Cards with DigiTest

You can use DigiTest to identify which cards are in which slots in your system. This is especially useful if you have multiple Digidesign cards of the same type installed in your system.

To Identify Digidesign cards with DigiTest

1. Quit Pro Tools if it is running.
2. Locate and double-click the DigiTest icon on your hard drive.

DigiTest opens and lists the supported cards it finds in your system.

3. Open your computer case or expansion chassis so you can see the top edge of the cards installed in your system.
4. In the DigiTest window, select the ID check box next to a card name. The green LED near the top edge of the corresponding card flashes.

Viewing Card Information with DigiTest

DigiTest can display identifying information such as serial number, date of manufacture, and firmware ROM version for each card in your system. This information is useful if you need to contact Digidesign Technical Support about your Pro Tools hardware.

To display information for a card in your system:

1. Quit Pro Tools if it is running.
2. Locate and double-click the DigiTest icon on your hard drive.
3. Click the Slot Info tab.
4. Choose a card slot from the pop-up menu.

Updating Audio Peripheral Firmware with DigiTest

If firmware updates are available for any of your Pro Tools|HD audio interfaces (192 I/O, 192 Digital I/O, 96 I/O, or 96i I/O), you can use DigiTest to perform the update. Within DigiTest, the Firmware Update page tells you the firmware version for the selected peripheral and lets you update to a newer version, if necessary.

To update the firmware in a Pro Tools|HD audio interface:

1. Quit Pro Tools if it is running.
2. Locate and double-click the DigiTest application on your hard drive.
3. Click the Firmware tab.
4. Choose a card slot from the pop-up menu. If any Pro Tools|HD audio interfaces are connected to the card, the Primary or Secondary options will become available in the HD Peripheral section of the Firmware page.

5. Under HD Peripheral, select Primary or Secondary to view the firmware version for the corresponding interface. The firmware version is displayed just below the HD Peripheral section of the Firmware page.

6. If the firmware version is not current, click Begin Update to update the firmware in the selected audio interface.

The status of the firmware update process is displayed in the status area at the bottom of the Firmware page.

7. After the update process is complete, click Quit to close DigiTest.
Configuring Pro Tools Software

Pro Tools System Settings

In the Playback Engine dialog, Pro Tools lets you adjust the performance of your system by changing system settings that affect its capacity for processing, playback, and recording. These system settings are available in the Playback Engine dialog (Setup > Playback Engine).

In most cases, the default settings for your system provide optimum performance, but you may want to adjust them to accommodate large or processing-intensive Pro Tools sessions.

Hardware Buffer Size

The Hardware Buffer Size (H/W Buffer Size) controls the size of the buffer used to handle host processing tasks such as Real-Time AudioSuite™ (RTAS) plug-ins.

- Lower Hardware Buffer Size settings are useful for improving latency issues in certain recording situations or for improving certain system performance problems.
- Lower settings reduce RTAS MIDI-to-audio latency (such as when playing an RTAS virtual instrument live and monitoring the instrument’s output). Lower settings can also improve screen response or the accuracy of plug-in and mute automation data.

- Lower settings reduce monitoring latency that occurs on tracks that have one or more RTAS plug-ins. Lower settings can also improve the accuracy of MIDI track timing on systems that are not using a MIDI I/O (or other MIDI interface that supports time stamping). Tracks using MIDI virtual instruments that do not support time stamping will also have better MIDI track timing with lower settings.
- Higher Hardware Buffer Size settings are useful for sessions that are using more RTAS plug-ins for playback. These settings allow for more audio processing. They can also be useful to reduce errors on machines that require a higher buffer size.

To change the Hardware Buffer Size:

2. From the H/W Buffer Size pop-up menu, select the audio buffer size, in samples.
3. Click OK.

Playback Engine dialog for Pro Tools | HD system
**RTAS Processors**

The RTAS Processors setting determines the number of processors in your computer allocated for RTAS (Real-Time AudioSuite) plug-in processing.

With multiprocessor computers, this setting lets you manage multi-processor support for RTAS processing. With multiple processor computers that support Hyper-Threading (and have it enabled), you must disable Hyper-Threading for this setting to become available. See your computer’s documentation for steps on how to enter the computer’s BIOS and disable Hyper-Threading.

Used in combination with the CPU Usage Limit setting, the RTAS Processors setting lets you control the way RTAS processing and other Pro Tools tasks are carried out by the system. For example:

- For sessions with large numbers of RTAS plug-ins, you can allocate 2 or more processors to RTAS processing and set a high CPU Usage Limit.
- For sessions with few RTAS plug-ins, you can allocate fewer processors to RTAS and set a low CPU Usage Limit to leave more CPU resources available for automation accuracy, screen response, and video.
- Increase these settings to accommodate TDM to RTAS plug-in conversion. Conversely, decrease these settings if you are only using TDM plug-ins or are converting RTAS plug-ins to TDM. TDM/RTAS conversion can be desirable during recording, depending on latency, voicing needs, and record-monitoring capabilities of the specific TDM and RTAS plug-ins.
- Depending on the importance of video and overall screen response, and on the density of automation being employed, try different combinations of RTAS Processing and CPU Usage Limit settings to achieve the best results. For example, to improve screen response in a medium-sized session using a moderate number of RTAS plug-ins, try reducing the number of RTAS plug-ins, but keep the CPU Usage Limit set to the maximum (99%) on a single processor system.

**To set the number of RTAS Processors:**


2. From the RTAS Processors pop-up menu, select the number of available processors you want to allocate for RTAS plug-in processing. The number of processors available varies depending on how many processors are available on your computer:
   - Choose 1 Processor to limit RTAS processing to one CPU in the system.
   - Choose 2 Processors to enable load balancing across two available processors.
   - On systems running four or more processors, choose the desired number of RTAS processors as needed.

3. Click OK.

**CPU Usage Limit**

The CPU Usage Limit controls the percentage of CPU resources allocated to Pro Tools host processing tasks. Used in combination with the RTAS Processors setting, the CPU Usage Limit setting lets you control the way Pro Tools tasks are carried out by the system.
Lower CPU Usage Limit settings limit the effect of Pro Tools processing on other CPU-intensive tasks, such as screen redraws, and are useful when you are experiencing slow system response, or when running other applications at the same time as Pro Tools.

Higher CPU Usage Limit settings allocate more processing power to Pro Tools, and are useful for playing back large sessions or using more real-time plug-ins.

The maximum available CPU Usage Limit depends on the number of processors in your computer and on the number of processors you specify for RTAS processing. This value can range from 85 percent for single-processor computers to 99 percent for multi-processor computers.

On multiprocessor computers, the maximum CPU Usage Limit is reduced when you use all your processors (as selected in the RTAS Processing pop-up menu). For example, on dual-processors, the limit will be 90%. On four-processor computers, the limit will be 95%.

Increasing the CPU Usage Limit may slow down screen responses on slower computers.

To change the CPU Usage Limit:

2. From the CPU Usage Limit pop-up menu, select the percentage of CPU processing you want to allocate to Pro Tools.
3. Click OK.

---

RTAS Engine (RTAS Error Suppression)

The RTAS Engine option determines RTAS error reporting during playback and recording. This is especially useful when working with instrument plug-ins.

You should only enable RTAS error suppression if you are experiencing frequent RTAS errors that are interrupting your creative workflow. When RTAS error suppression is enabled, you can experience a degradation of audio quality. However, this may be acceptable in order to avoid interrupting playback and recording when working with instrument plug-ins. Be sure to disable RTAS error suppression when you need to ensure the highest possible audio quality, such as for a final mix.

To enable RTAS error suppression:

2. Select Ignore Errors During Playback/Record.
3. Click OK.

---

RTAS Error Suppression Option

On Pro Tools|HD systems, there is a single RTAS Engine option:

Ignore Errors During Playback/Record When enabled, Pro Tools continues to play and record even if the RTAS processing requirements exceed the selected CPU Usage Limit. This can result in pops and clicks in the audio, but does not stop the transport.
**Number of Voices**

The Number of Voices setting lets you control the number of voices available on your system. For example, the default number of voices on an Pro Tools|HD 1 system is 48 voices, using one DSP (at sample rates of 44.1 kHz or 48 kHz).

Changing the number of voices affects DSP usage, the total number of voiceable tracks, and overall system performance.

Depending on the current sample rate and the number of cards in your system, and whether you are using an expansion chassis, you will have different choices for voice count.

> For additional information on voice count, refer to the Pro Tools Reference Guide.

**To change the Number of Voices and DSP to allocate for voicing:**

2. Select the number of voices and DSPs to allocate for voicing by choosing a value from the Number of Voices pop-up menu.

   - Select minimum voice numbers if you are using high-bandwidth PCI or PCIe cards (such as video capture cards) along with your Digidesign cards. These settings place the lightest processing load on each allocated DSP chip, but generally require more DSP chips be dedicated to voicing and mixing (leaving fewer available for plug-ins).

   - Select medium voice numbers when your Digidesign cards are in an expansion chassis, or when you are using other PCI or PCIe cards along with Digidesign cards. These settings generally provide an optimum balance between number of chips needed for voicing, and the processing load placed on each.

   - Select higher voice numbers when your Digidesign cards are the only PCI or PCIe cards in your computer, or when you are using an expansion chassis to run higher track counts (such as 64 tracks at 96 kHz) and you want more voices per DSP (such as 16 voices per DSP at 96 kHz). These settings use fewer DSP chips for mixing (leaving more available for plug-ins) but place the highest processing load on each.

3. Click OK.
Default Sample Rate

The Sample Rate setting determines the default sample rate when you create a new session. This setting is available only when there is no session open. Otherwise, the current session sample rate is displayed, but cannot be changed.

⚠️ The Sample Rate setting can affect the number of available voices.

💡 You can change the sample rate when creating a new Pro Tools session by selecting a different sample rate in the New Session dialog.

You can also change the default Sample Rate in the Hardware dialog, as long as no session is open.

To change the default Sample Rate in the Playback Engine:
2. Select the sample rate from the Sample Rate pop-up menu.
3. Click OK.

Delay Compensation Engine

The Delay Compensation Engine determines how much DSP resources are dedicated for Delay Compensation, which managing DSP delays in the Pro Tools mixer.

Within a session, you can choose to enable or disable Delay Compensation (Options > Delay Compensation).

Delay Compensation automatically manages DSP delays that occur on audio tracks, Auxiliary Inputs, or Master Faders because of plug-in use and mixer routing. With Delay Compensation enabled, Pro Tools maintains phase coherent time alignment between track outputs that have plug-ins with differing DSP delays, tracks with different mixing paths, tracks that are split off and recombined within the mixer, and tracks with hardware inserts.

To maintain phase coherent time alignment, Pro Tools adds the exact amount of delay to each track necessary to make that particular track's delay equal to the total system delay. The System Delay is shown in the Session Setup window.

Delay Compensation should be enabled during mixing and playback for phase coherent time alignment between track outputs. When recording, Delay Compensation should be turned off most cases.

⚠️ For more information on using Delay Compensation, see the Pro Tools Reference Guide.

To configure the Delay Compensation Engine:
2. From the Delay Compensation Engine pop-up menu, select a Delay compensation setting.
3. Click OK.

Delay Compensation Settings

There are three settings in the Playback Engine dialog for dedicating DSP resources for Delay Compensation:

None Allocates no DSP resources for Delay Compensation.

Short Allocates minimum DSP resources of Delay Compensation for each channel. This is the most efficient setting for Pro Tools|HD Accel systems. For sessions with only a few plug-ins that do not induce too much DSP-based delay, this setting should be sufficient.
Long Allocates maximum DSP resources for Delay Compensation for each mixer channel. For sessions with a lot of plug-ins resulting in a large amount of DSP-induced delay, select this setting.

**DAE Playback Buffer Size**

The DAE Playback Buffer Size determines the amount of memory DAE allocates for disk buffers. In addition to levels, the DAE Playback Buffer Size shows values in milliseconds, which indicates the amount of audio buffered when the system reads from disk.

The optimum DAE Playback Buffer Size for most disk operations is 1500 msec (Level 2).

- DAE Playback Buffer Size settings lower than 1500 msec (Level 2) may improve playback and recording initiation speed. However, a lower setting may make it difficult to play or record tracks reliably with sessions containing a large number of tracks or a high density of edits, or with systems that have slower or heavily fragmented hard drives.

- DAE Playback Buffer Size settings higher than 1500 msec (Level 2) allow higher track count, higher density of edits in a session, or the use of slower hard drives. However, a higher setting may increase the time lag when starting playback or recording, or cause a longer audible time lag while editing during playback.

Using a larger DAE Playback Buffer Size leaves less system memory for other tasks. The default setting of 1500 msec (Level 2) is recommended unless you are encountering -9073 (“Disk too slow or fragmented”) errors.

**To change the DAE Playback Buffer Size:**


2. From the DAE Playback Buffer pop-up menu, select a buffer size. Memory requirements for each setting are shown at the bottom of the Playback Engine dialog.

3. Click OK.

If Pro Tools needs more system memory for the DAE Playback Buffer, it will prompt you to restart your computer.

**Cache Size**

The Cache Size determines the amount of memory DAE allocates to pre-buffer audio for playback and looping when using Elastic Audio.

The optimum Cache Size for most sessions is Normal.

- A Cache Size setting of Minimum reduces the amount of system memory used for disk operations and frees up memory for other system tasks. However, performance when using Elastic Audio features may decrease.
• A Cache Size of Large improves performance when using Elastic Audio features, but it also decreases the amount of memory available for other system tasks, such as RTAS processing.

💡 Using a larger Cache Size leaves less system memory for other tasks. The default setting of Normal is recommended unless you are encountering -9500 (“Cache too small”) errors.

To change the Cache Size:
2. From the Cache Size pop-up menu, select a disk cache size.
3. Click OK.

System Memory Allocation
When you start your computer, Pro Tools automatically reserves a portion of system memory for the DAE Playback Buffer. This reserved memory is unavailable to other applications, even if Pro Tools is not running.

You can set Pro Tools to reserve only the minimum amount of required memory, so that more system memory is available to other applications.

To minimize system memory allocation:
2. Select the “Minimize System Memory Allocation” option.
3. Click OK.
4. Restart your computer.

Plug-in Streaming Buffer Size
(Structure Plug-in Only)
This setting appears in the Playback Engine dialog only if the Structure sampler instrument plug-in is installed on your system. The Plug-in Streaming Buffer Size determines the amount of memory DAE allocates for streaming playback from disk with the Structure plug-in. This setting only affects playback if disk streaming is activated in Structure’s plug-in controls (see the Structure Plug-in Guide for more information).

The optimum Plug-in Streaming Buffer Size for most sessions is 250 ms (Level 2).

• Plug-in Streaming Buffer Size settings lower than 250 msec (Level 2) reduce the amount of system memory used for sample playback and frees up memory for other system tasks. However, reliability of sample playback may decrease.

• Plug-in Streaming Buffer Size settings higher than 250 msec (Level 2) improve the reliability of sample playback, but they also decrease the amount of memory available for other system tasks, such as RTAS processing.

💡 Using a larger Plug-in Streaming Buffer Size leaves less system memory for other tasks. The default setting of 250 ms (Level 2) is recommended unless you are experiencing problems with the reliability of streaming playback from disk.
To change the Plug-in Streaming Buffer Size:

2. From the Plug-in Streaming Buffer Size pop-up menu, select a buffer size.
3. Click OK.

Optimizing the Plug-in Streaming Buffer Size
(Structure Plug-in Only)

This option appears in the Playback Engine dialog only if the Structure sampler instrument plug-in is installed on your system. This option is useful when you are playing samples from the same drive that contains audio for the current session. When this option is selected, Pro Tools automatically optimizes the size of the Plug-in Streaming Buffer to facilitate disk access from both Pro Tools and Structure. The Plug-in Streaming Buffer Size pop-up menu is unavailable when this option is selected.

To set Pro Tools to automatically optimize the Plug-in Streaming Buffer Size:

2. Select the “Optimize for Streaming Content on Audio Drives” option.
3. Click OK.

Configuring MIDI Setup

If you plan to use any MIDI devices with Pro Tools, do one of the following:

  - or –
- On Mac, configure your MIDI setup with Audio MIDI Setup. See Appendix D, “Configuring AMS (Mac OS X Only)” for details.

Configuring Pro Tools Hardware Settings

In the Hardware Setup dialog, Pro Tools lets you set the default sample rate and clock source for your system, as well as a range of controls specific to each type of audio interface.

Default Sample Rate

The Sample Rate setting appears as the default sample rate when you create a new session. (This setting is available in the Hardware Setup dialog only when no session is open.)

💡 You can change the sample rate when creating a new Pro Tools session by selecting a different sample rate in the New Session dialog.
To change the default Sample Rate:

1. Choose Setup > Hardware.
2. Choose the sample rate from the Sample Rate pop-up menu.
3. Click OK.

High Sample Rates and Expanded Systems

With 176.4 kHz and 192 kHz sample rates, as many as four Pro Tools|HD cards can be used. Any additional cards (up the total system maximum of seven cards) will switch to Inactive mode. The cards and any attached peripherals will become active again when the sample rate is set to 96 kHz or lower. See the Pro Tools Expanded Systems Guide for more information.

Clock Source

The Pro Tools Hardware Setup dialog lets you select the Clock Source for the system.

Internal If you are recording an analog signal directly into Pro Tools, you will usually use the Pro Tools Internal clock source.

External If you are transferring material into Pro Tools from an external digital device, or if you utilize a common house clock signal, you will synchronize Pro Tools to that digital device or common signal. Depending on your audio interface, external options can include AES/EBU, S/PDIF, Optical, AES/EBU 1–8, TDIF, ADAT, and Word Clock. For details, refer to the Pro Tools Reference Guide or the guide for your audio interface.

To select the Clock Source:

1. Choose Setup > Hardware.
2. Choose the clock source from the Clock Source pop-up menu.
3. Click OK.

⚠️ Your digital input device must be connected and powered on for Pro Tools to synchronize to it. If your input device is not powered on, leave the Clock Source set to Internal.

Configuring Audio Interfaces

Pro Tools|HD audio interfaces support 16 channels of simultaneous I/O and multiple I/O formats (including analog, AES/EBU, ADAT Optical, S/PDIF, and TDIF).

The Main page of the Hardware Setup dialog is where you define which physical inputs and outputs on your audio interface are routed to available inputs and outputs in Pro Tools. You can think of this window as a patchbay that allows you to route any of the inputs or outputs on your Pro Tools|HD audio interfaces to channel assignments in the Pro Tools mixer.
The Main page also provides controls for defining whether Expansion Port or Legacy Port peripherals are active.

Additional pages are available to configure other controls for each audio interface (such as setting operating levels).

**Identifying Audio Interfaces**

If you have multiple audio interfaces of the same type connected to your system, before you make audio connections to them, you should confirm the identity of each interface. This ensures that you choose the appropriate interface in the Peripherals list when you define its inputs and outputs in the Hardware Setup dialog.

**To identify audio interfaces in your system:**

1. Choose Setup > Hardware.

2. From the Peripherals list, select an audio interface connected to your system.

3. Make sure the Main page tab is chosen.

4. Select the Identify option, located in the lower left corner of the Hardware Setup dialog. This illuminates all the LEDs on the front panel of the selected audio interface.

5. Make a note of which interface in your studio setup corresponds to the identified interface.

6. Repeat the above steps for each additional audio interface in your setup.

Legacy I/Os must be initialized in the Peripherals list before they can be identified. See “Configuring Legacy I/Os” on page 50.

**To configure Pro Tools|HD audio interfaces:**

1. Choose Setup > Hardware.

2. From the Peripherals list, select the Digidesign audio interface connected to the first card in your system. This will be the interface at the top of the list.

3. Click the Main tab.

4. From the Clock Source pop-up menu, select the appropriate clock source for the interface.

In many cases, you will use Internal. The other choices are for resolving Pro Tools to external clock sources. Depending on your audio interface, Clock Source options can include: AES/EBU (Encl), S/PDIF, Optical (Encl), AES/EBU 1–8, TDIF, ADAT, and Word Clock (optional Word Clock rates are available when operating at higher sample rates).

5. If you want to send clock output to other devices attached to the audio interface, select the appropriate output from the Ext. Clock Output pop-up menu.

If the Legacy I/O Port is enabled (and not the Expansion I/O Port) then the Ext. Clock Output automatically switches to Slave Clock (256x sample rate). To reset the Ext. Clock Output to Word Clock, change the Port Settings back to Expansion I/O, then select the Legacy I/O in the Peripherals list, and set it to No Interface in the Interface pop-up menu. (The 96i I/O does not support Legacy I/O.)
6 Select which digital I/O port on your audio interface enclosure is active by selecting an option under Digital Format. Depending on the type of interfaces in your system, choices include AES/EBU, S/PDIF, and Optical (S/PDIF). Selecting Optical (S/PDIF) resets the Optical I/O port (which is, by default, eight channels of ADAT Optical I/O) to two channels of S/PDIF Optical I/O. (The 96i I/O supports stereo S/PDIF RCA digital input and output only.) For more information about Pro Tools|HD enclosure and card ports, refer to the guide for your audio interface.

7 For S/PDIF compatibility with Tascam DA-30 DAT recorders, select the Tascam option under S/PDIF Format.

8 For the 96 I/O and 96i I/O, click the Meters pop-up menu and select whether to meter the input or output signal.

9 From the Input and Output channel pop-up menus, select the physical ports (such as Analog 1–2 or Optical 1–2), that will be routed to the corresponding Pro Tools input and output channels (such as Ch 1–2, Ch 3–4), listed on the left side of the Main page. (This feature is not available with the 96i I/O.)

Inputs and outputs of similar format are differentiated in the input and output channel pop-up menus. For example, the AES/EBU inputs and outputs in the 192 I/O enclosure are listed as AES/EBU [Encl], while the AES/EBU inputs and outputs on the factory-installed Digital I/O card are listed (in pairs) as AES/EBU 1–2, AES/EBU 3–4, AES/EBU 5–6, and AES/EBU 7–8. For 192 I/Os equipped with the optional Digital I/O Card, the additional AES/EBU I/O ports on the optional card are listed as AES/EBU 9–10, AES/EBU 11–12, AES/EBU 13–14, and AES/EBU 15–16.

antiago Refer to your peripheral’s guide for configuration details and restrictions. For example, the Optical 1–8 channels (on the 192 I/O enclosure) will not be available at session sample rates of 88.2 kHz or higher, while the ports on the 192 I/O Digital I/O card will still be available.

10 Configure controls for your Pro Tools|HD audio interface. See “Configuring 192 I/O and 192 Digital I/O Controls” on page 48, “Configuring 96 I/O Controls” on page 49, and “Configuring 96i I/O Controls” on page 49.

11 For additional Pro Tools|HD interfaces, choose the interface in the Peripherals list, and repeat the above steps.
Configuring 192 I/O and 192 Digital I/O Controls

To configure controls for a 192 I/O:

1. With the 192 I/O selected in the Peripherals list, click the Analog In tab for the following options:
   - You can set your operating level on a channel-by-channel basis by selecting Reference Level +4 dBu or –10 dBV. These settings correspond to two different input connectors on the rear of the 192 I/O. Refer to the 192 I/O Guide for more information on setting operating levels.
   - Each of the analog channels in the 192 I/O has two Input Trims, labeled A and B, for precisely calibrating and switching levels. You can select Input Trim A or B on a channel-by-channel basis. Refer to the 192 I/O Guide for information on setting the rear panel trims.
   - You can select Soft Clip on a channel-by-channel basis. The Soft Clip limiter attenuates the incoming analog signal, providing extra protection from temporary clipping transients that can cause digital distortion when they exceed the maximum input of the unit. With Soft Clip enabled, 192 I/O supports an additional 4 dB of headroom by rounding off the top 4 dB to the clip point. This is useful for eliminating stray transients or for emulating analog tape saturation.

2. Click the Analog Out tab for the following option:
   - Each of the analog channels in the 192 I/O has two Output Trims, labeled A and B, respectively. You can select Output Trim A or B on a channel-by-channel basis.

To configure controls for a 192 Digital I/O or 192 I/O with an optional Digital I/O card:

- On the 192 Digital I/O or a 192 I/O with an optional Digital I/O card, click the Digital tab to set the Input Format (AES/EBU, TDIF, or ADAT Optical) and enable real-time sample rate conversion (in channel pairs, with the SR Conversion option).

💡 At session sample rates above 48 kHz, sample rate conversion for the TDIF and Optical (ADAT) inputs on the Digital I/O card is automatically enabled on all eight inputs of the selected format.
Configuring 96 I/O Controls

To configure controls for a 96 I/O:

1. With the 96 I/O selected in the Peripherals list, configure your I/O front panel meters for input or output metering from the Meters pop-up.

2. Click the Analog In tab for the following option:
   - You can set your operating level on a channel-by-channel basis by selecting Reference Level +4 dBu or –10 dBV. Refer to the 96 I/O Guide for more information on setting operating levels.

3. Click the Analog Out tab for the following option:
   - You can set your output level on a channel-by-channel basis by selecting Reference Level +4 dBu or –10 dBV. Refer to the 96 I/O Guide for more information on setting operating levels.

Configuring 96i I/O Controls

To configure controls for a 96i I/O:

1. With the 96i I/O selected in the Peripherals list, configure your I/O front panel meters for input or output metering from the Meters pop-up.

2. Set input sensitivity by doing the following:
   - For Inputs 1–4, set the input trim slider to match the output level of the connected instrument. Choices range from –12 dBV to +4 dBu. If you do not know the output level of the device, use the default input trim level, then fine tune the input level sensitivity.
   - For each input 5–16 being used, select –8 dBV or +4 dBu as appropriate to best match the output level of the connected instrument.

3. Set Output levels (select –10 dBV or +4 dBu).

4. Click Done.

You can select analog or digital input as sources for 96i I/O channels 1–2. Only channels 1–2 can access the S/PDIF inputs.
To select analog or digital input for channels 1-2:

1. Choose Setup > Hardware, and select 96i I/O in the Peripherals list to display the 96i I/O window.

2. Click to set Ch 1–2 Input to Analog or S/PDIF, as appropriate.

The 96i I/O only supports analog and digital switching for channels 1–2, and only from within the Hardware Setup and I/O Setup dialogs. The 96i I/O does not support path remapping within I/O Setup.

Configuring Legacy I/Os

Before you can configure a Legacy I/O, it must first be initialized in Hardware Setup.

To initialize a Legacy I/O on a Pro Tools|HD system:

1. Start up your Pro Tools system. See “Starting Up or Shutting Down Your System” on page 33.

Before turning on your Legacy I/O, make sure to lower the volume of your output devices. Very loud digital noise may be emitted before the Legacy I/O is initialized.

2. From the Peripherals list, choose the primary audio interface (the interface to which your Legacy I/O is connected).

3. In the Main page of the Hardware Setup dialog, select the Legacy I/O option under Port Settings.

4. In the Peripherals list, “No Interface” is listed twice, directly below the primary audio interface. Click the first “No Interface.” An Interface pop-menu appears in the Hardware Setup dialog, listing supported I/O choices.

5. From the Interface pop-up, select the type of Legacy I/O you connected.

After you select the type of Legacy I/O, the Main page updates with controls that can be configured. If your Legacy interface does not appear, check connections and repeat from step 1, above. See also “To remove a Legacy I/O:” on page 50.

6. Repeat the above steps for each additional Legacy I/O.

| For information on Hardware Setup controls for each Legacy I/O, refer to the guide for that interface. |

To remove a Legacy I/O:

1. Lower the volume of your output devices.

2. Turn off your Legacy I/O.

3. Choose Setup > Hardware in Pro Tools.

4. In the Main Page of the Hardware Setup dialog, select the Expansion I/O option under Port Settings.

5. In the Peripherals list, select the name of a Legacy interface.

6. From the Interface pop-up menu, choose “No Interface.”

7. Repeat the above steps for each additional Legacy I/O.

Offline Peripherals

When a Legacy I/O and Pro Tools|HD peripheral are connected to your primary Pro Tools|HD peripheral, only one can be online at a time. An offline peripheral is indicated by brackets in the Peripherals list of the Hardware Setup dialog. For example, if you have a 96 I/O and an 882|20 connected to a 192 I/O, and the 96 I/O is offline, it will appear in the Peripherals list as “[96 I/O].” Peripherals will also go offline if the audio interface or card to which they are attached is made inactive.
Configuring I/O Setup

The I/O Setup dialog provides a graphical representation of the signal routing for each connected audio interface, with controls to route physical ports on the audio interface to Pro Tools inputs and outputs. These controls mirror the routing controls found in the Hardware Setup dialog—changes made to physical routing in one dialog are always reflected in the other.

The I/O Setup dialog also lets you label and map Pro Tools input, output, insert, and bus signal paths. The I/O Setup dialog also provides important audition, meter, and surround settings.

Pro Tools comes with default I/O Setup settings that will get you started. You only need to go to I/O Setup if you want to remap or rename the default I/O paths or if you change your system hardware (for example, adding an expansion card to a 192 I/O).

Refer to the Pro Tools Reference Guide for more information on setting up I/O paths.

To configure I/O routing in I/O Setup:

1. Choose Setup > I/O.

2. Click the Input or Output tab to display the corresponding connections.

3. To change the name of a path or subpath, double-click directly on the Path Name, type a new name for the path, and press Enter.

4. To change the destination of an Input or Output path or subpath, click directly on an Input or Output Selector for an interface channel pair, just below an audio interface icon. (This feature is not available for the 96i I/O.)

5. From the pop-up menu, select a physical port pair (such as Analog 1–2), to route to the corresponding Pro Tools channel pair (such as A 1–2) in the Path Name column on the left.

6. Repeat the above steps for additional channel pairs.

7. Click OK.

Routing a Pro Tools Output Pair to Multiple Destinations

Pro Tools channel pairs can be routed to multiple outputs on your Digidesign audio interface through the Hardware Setup dialog.

For example, if you assign both Analog 1–2 and Analog 3–4 interface outputs to Pro Tools Output pair 1–2, when you send a signal to Pro Tools Output pair 1–2, that signal will be routed simultaneously to both pairs of output ports on your audio interface.

This lets you send the same signal (such as a stereo pair, a stem mix, or a multichannel mix) to multiple destinations (such as multiple mastering devices).
To route a Pro Tools output channel pair to multiple audio interface output ports:

1. Choose Setup > Hardware.
2. From the Peripherals list, select an interface.
3. Click the Main tab.
4. Select an output pair from an Output pop-up menu.
5. Start-click (Windows) or Control-click (Mac) the same pop-up menu a second time to choose an additional output port pair.

The output name updates with a plus sign (“+”) before it to indicate that multiple output ports are selected. In the pop-up menu, each physical port pair assigned to that Pro Tools output pair is indicated by a check mark.

6. Repeat the above steps to select additional output destinations. The only limit to output choices is the number of outputs available in your system.

Pro Tools output pairs can also be routed to multiple audio interface outputs in the I/O Setup dialog. For more information, see the Pro Tools Reference Guide.

Backing Up Your System Configuration

After configuring your system and Pro Tools, you should save an image of your system drive using a backup utility such as Norton Ghost (Windows) or Bombich Carbon Copy Cloner (Mac). By doing this, you can quickly restore your system configuration and settings if you encounter any problems.

Optimizing a Windows System for Pro Tools

(Windows XP Only)

To ensure optimum performance with Pro Tools|HD, configure your computer before using Pro Tools hardware and software.

For Mac System Optimization, see “Optimizing a Mac System for Pro Tools” on page 55.

Before configuring your computer, make sure you are logged in as an Administrator for the account where you want to install Pro Tools. For details on Administrator privileges, see your Windows documentation.

Required Optimizations

To ensure optimum performance with Pro Tools, configure the following settings before using Pro Tools hardware and software.

⚠️ When you are finished changing Windows system settings, restart your computer.
Enabling DMA

Enabling your computer's DMA (Direct Memory Access) frees up CPU bandwidth so your computer can do other Pro Tools tasks.

In most cases the DMA option will already be set correctly, as Windows detects and activates DMA mode by default.

To enable DMA for any IDE hard drives (Windows XP):

1. Choose Start > Control Panel.
2. Double-click System.
3. Click the Hardware tab.
4. Under Device Manager, choose Device Manager.
5. In the Device Manager window, double-click IDE ATA/ATAPI controllers, then double-click the Primary IDE Channel for your IDE hard drive.
6. Click the Advanced Settings tab.
7. For each device, set the Transfer Mode to “DMA if available,” and click OK.
8. Repeat the above steps for any additional IDE Channels.
9. Close the Device Manager window and then the System Properties window.

Disabling System Standby and Power Management

When using Pro Tools, the Windows System Standby power scheme must be set to Always On. This helps prevent long record or playback passes from stopping due to system resources powering down.

To configure Windows Power Management (Windows XP):

1. Choose Start > Control Panel.
2. Double-click Power Options.
3. Click the Power Schemes tab.
4. From the Power Schemes pop-up menu, select Always On.
5. Click OK.

This sets System Standby, System Hibernate, and “Turn off hard disks” to Never.

On AMD processors, be sure to check and disable Cool N' Quiet in the System BIOS (in the Cool & Quiet Configuration section). See the manufacturer’s documentation for instructions on disabling this power option, if necessary.

Disabling ClearType Font Smoothing

When using Pro Tools, the Effects “Clear Type” setting must be disabled.

To disable ClearType font smoothing (Windows XP):

1. Choose Start > Control Panel.
2. Double-click Display.
3. Click the Appearance tab.
4. Click Effects.
5. Deselect “Use the following method to smooth edges of screen fonts.”
6. Click OK to save your settings and close the Effects dialog.
7. Click OK.
8. Restart the computer.
**Recommended Optimizations**

Pro Tools can also be affected by other software and hardware drivers installed on your computer. For best possible performance, it is recommended (but not required) that you do the following:

- Avoid running any unneeded programs at the same time as Pro Tools.
- Turn off any software utilities that run in the background, such as Windows Messenger, calendars, and disk maintenance programs.
- Turn off any non-essential USB devices while running Pro Tools.
- If your video display card supports it, enable Bus Mastering in the manufacturer’s Control Panel. See the manufacturer’s instructions for details.

**Optional Optimizations**

The following system optimizations may help Pro Tools perform better on some systems. It is recommended that you only try these optimizations if necessary, as they may disable or adversely affect the functionality of other programs on your system.

**Disabling Network Cards**

If applicable, disable any networking cards (other than a FireWire card that you might use to connect an external drive to your system).

**To disable a network card:**

1. Right-click My Computer and choose Manage.
2. Under System Tools, select Device Manager.
3. In the Device Manager window, double-click Network adapters, then double-click the Network Adapter card you want to disable.
4. Under the General tab, choose “Do not use this device (disable)” from the Device Usage pop-up menu, and click OK.
5. Close the Computer Management window.

**Adjusting Processor Scheduling**

**To adjust Processor Scheduling performance:**

1. Choose Start > Control Panel.
2. In Classic View, double-click System.
3. Click the Advanced tab.
4. Under the Performance section, click the Settings button.
5. In the Performance Options window, click the Advanced tab.
6. Under the Processor Scheduling section, select the Background Services option.
7. Under the Memory Usage section, select the System cache option.
8. Click OK to close the Performance Options window.
9. Click OK to close the System Properties window.
10. Restart the computer for the changes to take effect.
Disabling System Startup Items

The fewer items in use by your computer, the more resources are available for Pro Tools. Some startup applications may be consuming unnecessary CPU resources, and can be turned off.

If you disable any of the following startup items, do so carefully:

- Portable media serial number (required for some applications that utilize a copy protection key)
- The Plug and Play service
- Event log
- Cryptographic services

To Disable System Startup Items (Windows XP):

1. From the Start menu, choose Run.
2. Type “msconfig” and click OK. The System Configuration Utility opens.
3. Under the General tab, choose Selective Startup.
4. Deselect Load Startup Items and click OK.
5. Click Restart to restart the computer.
6. After restarting, the computer displays a System Configuration message. Check to see if Pro Tools performance has increased before you deselect the “Don’t show this message again” option. If performance has not changed, run “msconfig” and return your computer Startup Selection back to Normal Startup - load all device drives and services. Alternatively, try disabling Startup items and non-essential processes individually.

Optimizing a Mac System for Pro Tools

(Mac Only)

For Windows System Optimization, see “Optimizing a Windows System for Pro Tools” on page 52.

To ensure optimum performance with Pro Tools, configure your computer before using Pro Tools software.

Before configuring your computer, make sure you are logged in as an Administrator for the account where you want to install Pro Tools. For details on Administrator privileges in Mac OS X, see your Apple OS X documentation.

Do not use the Mac OS X automatic Software Update feature, as it may upgrade your system to a version of Mac OS that has not yet been qualified for Pro Tools. For details on qualified versions of Mac OS, see the latest compatibility information on the Digidesign website (www.digidesign.com).

Turning Off Software Update

To turn off the Software Update feature:

1. Choose System Preferences from the Apple menu and click Software Update.
2. Click the Software Update tab.
3. Deselect Check for Updates.
Turning Off Energy Saver

To turn off the Energy Saver feature:
1. Choose System Preferences from the Apple menu and click Energy Saver.
2. Click the Sleep tab and do the following:
   • Set the computer sleep setting to Never.
   • Set the display sleep setting to Never.
   • Deselect “Put the hard disk(s) to sleep when possible” option.

Setting Processor Performance

To set the Processor Performance:
1. Choose System Preferences from the Apple menu and click Energy Saver.
2. Click the Options tab and set Processor Performance to Highest.

Disabling Spotlight Indexing

The Mac OS X Spotlight feature indexes files and folders in the background, affecting system performance. It is recommended that you disable Spotlight indexing before using Pro Tools.

Disabling Spotlight indexing will cause the Find function in Mac OS X to no longer work. You will no longer be able to search for files on drives set to private.

To disable Spotlight indexing:
1. Choose System Preferences from the Apple menu and click Spotlight.
2. In the Spotlight window, click the Privacy tab.
3. To prevent indexing of a drive, drag its icon from the desktop into the list.

Disabling the Spotlight Shortcuts

The Mac OS X Spotlight feature uses the same key commands Pro Tools uses to start recording (Command+Spacebar), and to record online (Command+Option+Spacebar). If you want to retain use of these key commands in Pro Tools, these shortcuts must be disabled.

To disable the Spotlight keyboard shortcut:
1. Choose System Preferences from the Apple menu and click Spotlight.
2. Deselect “Spotlight menu keyboard shortcut” and “Spotlight window keyboard shortcut.”

Disabling the Dashboard Shortcut

The Mac OS X Dashboard feature uses the same key command Pro Tools uses to start recording (F12). If you want to retain use of this key command in Pro Tools, this shortcut must be disabled.

To disable the Dashboard keyboard shortcut:
1. Choose System Preferences from the Apple menu and click Dashboard and Exposé.
2. Set the Dashboard keyboard shortcut to “-” to disable the shortcut.

Enabling Journaling for Audio Drives

To yield higher performance from audio drives, enable journaling.

To enable journaling:
1. Launch the Disk Utility application, located in Applications/Utilities.
2. Select the volume in the left column of the Disk Utility window.
3. Click Enable Journaling in the toolbar.
Making Studio Connections

This chapter provides general information on connecting Pro Tools to your system, including digital equipment, effects units, MIDI gear, and SMPTE synchronization devices.


- Front and back panel connectors and indicators
- Installation of optional expansion I/O cards (192 I/O only)

⚠️ Pro Tools HD audio interfaces need room at their sides to maintain proper air flow for cooling. Do not block the sides of the unit or disconnect the internal fan. If the units are rack-mounted in a case, remove the case lids or doors before operating the system. Failure to do so can result in the units overheating very quickly, which can permanently damage sensitive components.

Setting Up Your Studio

Figure 5 illustrates a typical studio setup, with a 192 I/O connected to a mixing console, effects and other equipment.

Figure 6 illustrates a setup without a mixer, where effects and monitoring gear are connected directly to a 96 I/O.
Example Studio Setup with a Mixing Console

Figure 5. Typical studio configuration using a 192 I/O with mixer connections
Example Studio Setup without a Mixing Console

Figure 6. Typical studio configuration using a 96 I/O without a mixer
**192 I/O**

The 192 I/O features two DB-25 breakout connectors for two sets of eight inputs each, at +4 dBu and –10 dBV respectively.

There are no –10 dBV outputs, however; analog outputs break out from a single DB-25 output at +4 dBu operating levels.

⚠️ *When driving unbalanced lines on the 192 I/O output card, leave the negative “−” terminals disconnected. Failure to do so will result in noisy outputs.*

The 192 I/O requires a custom DB-25 snake. Digidesign sells several different DigiSnake DB-25 cables for this purpose. Contact your dealer or Digidesign for more information.

**192 Digital I/O**

The 192 Digital I/O features two DB-25 breakout connectors for two sets of eight AES/EBU or TDIF inputs and outputs, along with a pair of ADAT Optical ports.

The 192 Digital I/O requires a custom DB-25 snake. Digidesign sells several different DigiSnake (DB-25) cables for this purpose. Contact your dealer or Digidesign for more information.

**96 I/O**

The 96 I/O analog connectors are TRS 1/4-inch with TIP wired hot (or “+”), RING cold (or “−”), and SLEEVE ground. If connecting to unbalanced loads, use unbalanced TS cables.

There is one bank of eight inputs (software-switchable between +4 dBu and –10 dBV line levels on a line-by-line basis).

There is one bank of eight outputs (that use +4 dBu line levels).

**96i I/O**

The 96i I/O analog connectors are balanced TRS 1/4-inch with TIP wired hot (or “+”), RING cold (or “−”), and SLEEVE ground. If connecting to unbalanced loads, use unbalanced TS cables.

The 96i I/O provides 16 inputs and two outputs. Inputs 1–4 feature variable, multi-level input sensitivity, controllable from within Pro Tools (from –12 dBV to +4 dBu). Inputs 5–16 provide a choice of two fixed operating levels (–8 dBV or +4 dBu).

Outputs 1–2 are selectable between –10 dBV and +4 dBu.

---

**Connecting Equipment with Digital Audio Ins and Outs**

Each Pro Tools|HD audio interface includes at least one AES/EBU, S/PDIF, or Optical (ADAT) digital option. For example, the 192 I/O includes additional AES/EBU and optical ports, as well as TDIF, dual-wire AES/EBU at 192 kHz, and sample rate converters. The 96i I/O provides two channels of S/PDIF only. (See the documentation for your audio interface for details.)

The following example provides basic setup guidelines for connecting Pro Tools to a DAT recorder.

**To connect your Pro Tools system to a DAT recorder:**

1. Connect the AES/EBU or S/PDIF output on the enclosure of your Pro Tools|HD audio interface to the AES/EBU or S/PDIF input of your DAT deck. By default, this port is assigned to Pro Tools Output 1–2.
Connect the AES/EBU or S/PDIF input on the enclosure to the AES/EBU or S/PDIF output of your DAT deck. Route the digital input to Pro Tools inputs in the Hardware Setup dialog.

You can route any of the physical input or output pairs to any of the input and output channel assignments in the Pro Tools mixer. (The 96i I/O does not support input mapping, however.) For more information see the Pro Tools Reference Guide.

Connecting Effects Units

The 192 I/O, 192 Digital I/O and 96 I/O let you connect analog or digital effects units to your Pro Tools system, and use them as inserts or make them the destination for effects sends and returns. (The 96i I/O supports a single pair of hardware inserts using channels 1–2. See the 96i I/O Guide for more information.)

Five inserts are available on each audio channel. Each insert can be a hardware insert (or software plug-in), and can be mono or stereo.

When using a hardware insert, you must connect the device to matching inputs and outputs on your system. For example, a stereo insert could use outputs 7–8 and inputs 7–8 for the sends and returns, respectively. Routing the physical inputs and outputs of the interface to Pro Tools inputs and outputs can be done in either the Hardware Setup dialog or I/O Setup dialog. From I/O Setup, inserts can also be defined, and their channels mapped to audio interface channels. (For more information, see the Pro Tools Reference Guide).

You can also connect effects units to your system by using any analog or digital inputs and outputs as Auxiliary Inputs and Outputs for effects sends and returns. Once an effects unit is attached this way, you can send a variable amount of a track’s output to the effects unit using a send in Pro Tools.

Ten separate send controls on each Pro Tools track allow you to route audio to any of the available outputs connected to your system or through any of the 128 internal busses in the Pro Tools Mixer. Outputs can be returned to Auxiliary Inputs for automated mixing or processing.

When you are using an effect in this send and return type of configuration, make sure the unit’s internal mix or balance between direct (unprocessed) and wet (effected) signal is set so that only the processed signal is returned to Pro Tools. On most effect units, a balance setting of 100% (completely wet) is the appropriate setting.

If you’ve been using an effects unit in an instrument setup, such as a guitar effects rack, you’ll probably find the balance to be below 50%. If the unit has separate dry and effect level knobs, turn dry level control off. If you don’t do this, the dry, unprocessed signal will be present in an effect’s output along with the desired processed sound, and you’ll have trouble accurately controlling the effect balance in your final mix.
Connecting Effects Units Digitally

To use your audio interface's inputs and outputs as effects sends and returns to a digital effects device, set your interface’s Clock Source to Internal in the Hardware Setup dialog (unless it is referenced to another clock source or peripheral). You should then set your digital effects devices to accept an external digital clock so that they will synchronize themselves to Pro Tools. Make sure you set the channel pair to the digital input in the Hardware Setup dialog (or I/O Setup dialog).

Connecting MIDI Devices

By adding a compatible MIDI interface to your system, you can take advantage of all the MIDI features of Pro Tools, including recording and editing MIDI tracks, and synchronizing to MIDI Time Code or MIDI beat clock.

USB MIDI interfaces work effectively with Pro Tools systems on Windows or Mac. Serial MIDI interfaces are supported on Windows systems only.

⚠️ Only USB MIDI interfaces are compatible with Pro Tools systems on Mac OS X. Modem-to-serial port adapters and serial MIDI devices are not supported.

See Appendix C, “Configuring MIDI Studio Setup (Windows Only)” or Appendix D, “Configuring AMS (Mac OS X Only)” for detailed information on how to identify external MIDI devices connected to your MIDI interface and configure your MIDI studio for use with Pro Tools.

To connect MIDI devices to your system:

1. Connect the MIDI interface to your computer according to the MIDI interface’s documentation.
2. Install any MIDI driver software required by the MIDI interface. (Once you have installed your MIDI interface hardware and software, confirm that it is working properly using the procedure given in the interface’s documentation.)
3. Connect the MIDI OUT of your MIDI device to the MIDI IN of your MIDI interface.
4. Connect the MIDI IN of your MIDI device to the MIDI OUT of your MIDI interface.

Connecting SMPTE Synchronization Devices

If you intend to synchronize Pro Tools to external devices with SMPTE, your system must be connected properly. For details on SMPTE and synchronization, see the Pro Tools Reference Guide or the SYNC I/O Guide.

Digidesign SYNC I/O

Digidesign’s SYNC I/O is a multi-purpose synchronization peripheral that provides all the functions and connections needed to synchronize to a variety of devices with Pro Tools|HD. SYNC I/O lets you synchronize Pro Tools to LTC, VITC, and Bi-Phase/Tach, or internal for positional reference (time code), and supports all major clock references.
SYNC I/O integrates into the Loop Sync configuration of a Pro Tools|HD system, offering extremely fast lockup, near-sample accurate synchronization, and an exceptionally low-jitter clock. These features provide professional performance and maximum audio fidelity under a wide range of synchronization conditions.

For more information, refer to the SYNC I/O Guide.

**Connecting Ethernet Control Surfaces**

If you are using a built-in Ethernet port or a PCI or PCIe Ethernet card to connect your computer directly (rather than across a network) to a D-Control, D-Command, ProControl or Control|24, the TCP/IP address must be set manually. The default manual settings will work in most cases. Do not use DHCP unless your computer is connected to a network that provides DHCP services.
Connecting SCSI Drives

SCSI hard drives are the recommended recording media for Pro Tools|HD systems on Windows, and can also be used with Pro Tools on the Mac.

Although Pro Tools will let you record to your system drive, this is generally not recommended. Performance for recording and playback on system drives is sometimes worse than on non-system drives, resulting in lower track counts and fewer plug-ins.

Be aware that recording to your system drive can quickly use up available hard drive space. This can negatively affect system stability and the performance of all applications including Pro Tools.

For the most current information on hard drive requirements and recommendations, see the Digidesign website (www.digidesign.com).

SCSI Requirements

Digidesign recommends qualified SCSI hard drives and a qualified SCSI host bus adapter (HBA) card or (on Windows systems) a qualified built-in SCSI HBA connector on the motherboard.

For a list of qualified SCSI hard drives and SCSI HBA cards, see the Digidesign website (www.digidesign.com).

Software RAID is not supported for audio drives.
SCSI Cables

Use shorter SCSI cables to improve reliability. Table 1 provides guidelines for maximum cable lengths according to SCSI type.

In the following table, the maximum cable length includes all cables used in the chain, not just point-to-point connections.

Table 1: Maximum cable length and number of drives supported according to SCSI type

<table>
<thead>
<tr>
<th>SCSI Type and Transfer Rate</th>
<th>Maximum Cable Length</th>
<th>Maximum Number of Drives</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast SCSI 10 MB/sec</td>
<td>3 meters</td>
<td>8</td>
</tr>
<tr>
<td>Wide SCSI 20 MB/sec</td>
<td>3 meters</td>
<td>16</td>
</tr>
<tr>
<td>Ultra SCSI 20 MB/sec</td>
<td>3 meters</td>
<td>5</td>
</tr>
<tr>
<td>Ultra SCSI 40 MB/sec</td>
<td>3 meters</td>
<td>5</td>
</tr>
<tr>
<td>8-bit narrow</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ultra SCSI 20 MB/sec</td>
<td>1.5 meters</td>
<td>6–8</td>
</tr>
<tr>
<td>8-bit narrow</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ultra SCSI 40 MB/sec</td>
<td>1.5 meters</td>
<td>6–8</td>
</tr>
<tr>
<td>16-bit wide</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ultra1 SCSI Low Voltage</td>
<td>12 meters</td>
<td>16</td>
</tr>
<tr>
<td>Differential (LVD) 160 MB/sec</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ultra2 SCSI Low Voltage</td>
<td>12 meters</td>
<td>16</td>
</tr>
<tr>
<td>Differential (LVD) 80 MB/sec</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ultra3 SCSI Low Voltage</td>
<td>12 meters</td>
<td>16</td>
</tr>
<tr>
<td>Differential (LVD) 320 MB/sec</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Distribute Audio Across Multiple Drives

For best recording and playback performance, don’t record and play back all audio files in a session from the same drive. Instead, use Pro Tools Disk Allocation features to distribute audio files between multiple drives. See the Pro Tools Reference Guide for details.

Separate Video and Audio Files

If you are working with QuickTime, movie files must reside on a different SCSI bus than audio files. If audio files reside on disks connected to a SCSI HBA card, video data should reside on drives connected to a different SCSI bus.

Dual-Channel SCSI HBA Cards

If you use a dual-channel SCSI HBA card, allocate audio files equally to drives connected to each of the two busses on the card for optimal performance.

If using video files, make sure to put your video files on one bus and audio files on the other bus.

Connecting SCSI Drives

To connect an external SCSI drive:

1. Turn off power to both the computer and the hard drive.
2. Attach a SCSI cable from the SCSI port of the hard drive to the SCSI port of the SCSI HBA card or computer.
3. Secure the cable’s connectors to the hard drive and computer.
4. Connect additional drives by daisy-chaining from one drive to another. Keep cable lengths to a minimum (see Table 1).
5 Verify that the last SCSI device in the chain is properly terminated. (See “SCSI Termination” on page 67.)

6 Make sure each SCSI device has a unique ID.

⚠️ **SCSI ID 7 is reserved for the host computer. Do not use ID 7 with any of your SCSI devices.**

7 Attach power cables to the hard drives.

---

### SCSI Termination

Your computer’s SCSI chain must be properly terminated or your system will not function correctly. Only the last device on the chain should be terminated using the termination type recommended by the hard drive manufacturer.

The drive should use either an external terminator plug or have its internal terminators enabled. If you are using a terminator plug, Digidesign recommends that you purchase and use an active terminator.

⚠️ **Do not enable internal termination and install an external terminator plug on the same drive. This will cause SCSI errors. See your hard drive’s documentation for information on which type of termination it uses.**
Appendix B: Hard Drive Configuration and Maintenance

It is recommended that you start with a newly formatted external or secondary internal audio drive. You should also periodically defragment your audio drive to ensure continued system performance.

⚠️ Always back up any important data on your drive before formatting it, as it will erase all data on the drive.

Avoid Recording to the System Drive

Recording to your system drive is not recommended. Recording and playback on a system drive may result in lower track counts or fewer plug-ins.

Supported Drive Formats and Drive Types

Drive Formats

Windows

Windows XP systems should use drives formatted as NTFS only.

Mac

Mac systems should use drives formatted with HFS or HFS+ file system only.

⚠️ HFS drives are supported as Transfer drives only.

Hard drive performance depends on factors including system configuration, number of tracks, session sample rate, density of edits, and the use of crossfades and other processes such as Beat Detective in a session.

For complete hard drive requirements, see the Digidesign website (www.digidesign.com).

SCSI Hard Drives

Digidesign recommends qualified SCSI hard drives and a qualified SCSI host bus adapter (HBA) card or (on Windows systems) a qualified built-in SCSI HBA connector on the motherboard.

⚠️ For more information, see Appendix A, “Connecting SCSI Drives.”

For complete information on track count and the supported number and configuration of SCSI drives, visit the Digidesign website (www.digidesign.com).
FireWire Hard Drives

Digidesign recommends qualified FireWire drives and (on Windows systems) a qualified FireWire host adapter.

For complete information on track count and the supported number and configuration of FireWire drives, visit the Digidesign website (www.digidesign.com).

IDE/ATA/SATA Hard Drives

A qualified internal IDE/ATA/SATA drive may be used as a dedicated audio drive.

For complete information on track count with internal drives, refer to the Digidesign website (www.digidesign.com).

**IDE/ATA/SATA hard drives provide limited track count performance and are not supported when an Expansion Chassis is used.**

For more information regarding Expansion Chassis operating procedures, see the Pro Tools Expanded Systems Guide.

Formatting an Audio Drive

To format an audio drive:

1. Right-click My Computer and choose Manage.
2. Under Storage, choose Disk Management.

   ![Disk Management window](image)

3. If the volume is “Healthy,” do the following:
   - In the Disk Management window, right-click the hard drive you will use for audio and choose Format.
   - In the Format window, name the volume.
   - Choose a file system. For optimum performance, audio drives should be formatted as NTFS.
   - Select “Perform a quick format.”
   - Make sure “Enable file and folder compression” is not selected.
   - Set the Allocation unit size to Default.
   - Click OK.

   ![Pro Tools only supports Basic drive types. Do not convert the drive to a Dynamic type.](image)
If the volume is “Unallocated,” do the following:

- In the Disk Management window, right-click the hard drive you will use for audio and choose New Partition.
- In the New Partition Wizard window, click Next.
- When prompted, select the partition type.

**Digidesign recommends using Primary partitions, instead of Extended partitions.**

- Follow the on-screen instructions to select a partition size and other partition settings.
- When prompted, choose a file system. For optimum performance, audio drives should be formatted as NTFS.
- Select “Perform a quick format.”
- Make sure “Enable file and folder compression” is not selected.
- Set the Allocation unit size to Default.
- Click OK.

**Pro Tools only supports Basic drive types. Do not convert the drive to a Dynamic type.**

**Formatting Mac Audio Drives**  
**(Mac Only)**

For optimum performance, audio drives should be formatted as Mac OS Extended (Journaled).

**To format an audio drive:**

1. Launch the Disk Utility application, located in Applications/Utilities.

2. Click the Erase tab.

3. Select the drive you want to initialize in the column on the left side of the window.

4. Choose the Mac OS Extended (Journaled) format.

- Do not choose the “Case-Sensitive” format option. Pro Tools will not operate properly with case-sensitive formatted drives.

5. Type a name for the new volume.

6. If you plan to connect the drive to a Mac OS 9 computer, select Install Mac OS 9 Drivers.

7. Click Erase.

The drive appears on the Desktop with the new volume name.
Partitioning Drives

Partitioning creates a logical volume or volumes on a physical drive, almost as if you were creating virtual hard drives. Partitions can then be formatted with the appropriate file system (NTFS for Windows, HFS+ for Mac).

Windows XP allows drives formatted with the NTFS file system to be seen as whole volumes. Single Pro Tools audio files cannot exceed 2048 MB in size.

Mac OS allows drives larger than 4096 MB to be seen as whole volumes. Drives must be initialized with a disk utility that recognizes the 2 terabyte limit. Single Pro Tools audio files cannot exceed 2048 MB in size.

Seek Times on Partitioned Drives

Seek times are actually faster on partitioned drives (assuming that reads and writes are performed on a single partition), since the heads only have to seek within the partition boundaries, rather than the whole capacity of the drive.

Smaller partitions perform faster than larger partitions, but this comes at the expense of contiguous storage space. When you partition a drive, you will need to find the compromise that best suits your performance and storage requirements.

Avoid distributing audio files within a session over different partitions on the same drive since this will adversely affect drive performance.

Defragmenting an Audio Drive

Mac Systems

When working with larger files (such as video), you can limit fragmentation by backing up your important files to another disk, erasing the files from the original hard disk, then copying the files back, instead of doing a defragmentation.

Window Systems

Periodically defragment audio drives to maintain system performance.

For maximum recording and playback efficiency, data should be written to your hard drive in a contiguous fashion—minimizing the seek requirements to play back the data. Unfortunately, your computer can’t always store the sound files in this way and must write to disk wherever it can find space.

In multitrack recording, audio tracks are written in discrete files, spaced evenly across the disk. While fragmentation of individual files may be zero, the tracks may be far enough apart that playback will still be very seek-intensive. Also, the remaining free space on the disk will be discontinuous, increasing the likelihood of file fragmentation on subsequent record passes.

Increased fragmentation increases the chance of disk errors, which can interfere with playback of audio, and result in performance errors.

On Windows, to avoid fragmentation, format drives with higher cluster sizes (such as 32K).
Optimizing (Defragmenting) Drives

To prevent fragmentation, you can optimize your drive, which rearranges your files into a contiguous format. Most optimizing software lets you run a check on a drive to find out the percentage of fragmentation. If your drive shows moderate to heavy fragmentation, you should consider optimizing it.

If you use your system for intensive editing, or if you frequently delete audio or fade files from your hard drive, you may need to optimize your drives on a weekly basis, or even every few days, since it doesn’t take long for even a large hard drive to become fragmented.

Backing Up Data Before Optimizing

Since your files will be rewritten by the optimization process, always make a backup copy of the data on your hard drive before you optimize it. You should also use a hard drive utility to find and repair any problems before optimizing data or re-initializing your drives. If there is any damage to your hard drive’s directories prior to optimizing, serious data loss may result.

Defragmenting Windows Audio Drives

To defragment an audio drive:

1. Right-click My Computer and choose Manage.
2. Under Storage, choose Disk Defragmenter.
3. In the Disk Defragmenter window, choose the drive you want to defragment.
4. Click the Defragment button and follow the on-screen instructions.

When defragmenting is complete, close the Computer Management window.

Using Mac Drives on Windows Systems

Pro Tools for Windows lets you record and play back sessions directly from a Mac-formatted (HFS+) drive connected to a Windows system. This functionality requires that all Mac session and audio files be stored on Mac-formatted drives.

During Pro Tools installation, make sure to select the Mac HFS+ Disk Support option. This option lets your Pro Tools system read, write, record, and play back using Mac-formatted HFS+ disks.

For information on using the Mac HFS+ Disk Support option, see the Mac HFS+ Disk Support Option Guide.

For information on sharing sessions between Mac and Windows systems, see the Pro Tools Reference Guide.

Formatting and Maintaining HFS+ Drives

To format and partition any drives as HFS+, connect the drives to a Mac computer and use the Apple OS X Disk Utility.
Hard Disk Storage Space

Mono audio tracks recorded with 16-bit resolution at 44.1 kHz (CD quality) require approximately 5 MB of hard disk space per minute. The same tracks recorded with 24-bit resolution require about 7.5 MB per minute.

Stereo audio tracks recorded with 16-bit resolution at 44.1 kHz (CD quality) require approximately 10 MB of hard disk space per minute. The same tracks recorded with 24-bit resolution require about 15 MB per minute.

Table 3 lists the required disk space for certain track numbers and track lengths, to help you estimate your hard disk usage.

Table 3. Required hard drive space for audio tracks (44.1 kHz and 48 kHz sessions shown)

<table>
<thead>
<tr>
<th>Number of Tracks and Length</th>
<th>16-bit at 44.1 kHz</th>
<th>16-bit at 48 kHz</th>
<th>24-bit at 44.1 kHz</th>
<th>24-bit at 48 kHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 mono track, 1 minute</td>
<td>5 MB</td>
<td>5.5 MB</td>
<td>7.5 MB</td>
<td>8.2 MB</td>
</tr>
<tr>
<td>1 stereo track (or two mono tracks), 5 minutes</td>
<td>50 MB</td>
<td>55 MB</td>
<td>75 MB</td>
<td>83 MB</td>
</tr>
<tr>
<td>1 stereo track (or two mono tracks), 60 minutes</td>
<td>600 MB</td>
<td>662 MB</td>
<td>900 MB</td>
<td>991 MB</td>
</tr>
<tr>
<td>24 mono tracks, 5 minutes</td>
<td>600 MB</td>
<td>662 MB</td>
<td>900 MB</td>
<td>991 MB</td>
</tr>
<tr>
<td>24 mono tracks, 60 minutes</td>
<td>7 GB</td>
<td>7.8 GB</td>
<td>10.5 GB</td>
<td>11.6 GB</td>
</tr>
<tr>
<td>32 mono tracks, 5 minutes</td>
<td>800 MB</td>
<td>883 MB</td>
<td>1.2 GB</td>
<td>1.3 GB</td>
</tr>
<tr>
<td>32 mono tracks, 60 minutes</td>
<td>9.4 GB</td>
<td>10.4 GB</td>
<td>14 GB</td>
<td>15.4 GB</td>
</tr>
</tbody>
</table>
**Appendix C: Configuring MIDI Studio Setup (Windows Only)**

**MIDI Studio Setup**

MIDI Studio Setup (MSS) lets you configure the MIDI controllers and sound modules that are connected to your system, and control the routing of MIDI data between your MIDI equipment and Pro Tools.

MSS automatically finds MIDI interfaces, and lets you specify a custom name for each of the MIDI ports within the MIDI Studio Setup document.

MSS also supports XML-based patch file names for storing and importing patch names for your external MIDI devices.

Entire MIDI Studio Setup configurations created within MSS can be imported and exported.

**MIDI Studio Setup Window**

The MIDI Studio Setup window is organized into three sections. Interface controls are at the top of the window. All the currently defined instruments are displayed in the Instrument Name list on the left side of the window. A detailed view of MIDI parameters is shown in the Properties section on the right.

![MIDI Studio Setup window](image)

**Interface Controls**

- **Create** This button adds a new instrument to the Instrument Name list.

- **Delete** This button deletes the instrument or instruments selected in the Instrument Name list.

- **Import** This button lets you import an existing MIDI Studio Setup file.

- **Export** This button lets you export the current MIDI Studio Setup file.
Show Duplicate Emulated Ports If you are using a MIDI interface that supports timestamping (such as MIDI I/O), when the Show Duplicate Emulated Outputs option is selected, the MIDI Studio Setup window shows both the DirectMusic time-stamped output ports, and non-stamped duplicate emulated output ports.

⚠️ Some MIDI Interfaces will not properly load or unload their drivers unless you quit and re-launch Pro Tools. Check the documentation that came with your MIDI interface for more information.

Instrument List

The Instrument list contains all the currently defined instruments. Selecting an instrument in the list displays that instrument’s properties in the Properties section of the window.

Properties Section

The Properties section lets you edit information for new instruments, or instrument currently selected in the Instrument list.

When a previously defined instrument is selected in the Instrument list, the Properties section changes to reflect the properties of the selected instrument.

To define an instrument with MIDI Studio Setup:

1. Choose Setup > MIDI > MIDI Studio.
2. Click Create.
3. In the Instrument Name field, type the name of your instrument, and press Enter.
4. Set a manufacturer and model for the new device from the corresponding pop-up menus. If the Manufacturer and Model pop-up menus do not provide a name for your particular device, choose None.
5. From the Input pop-up menu, choose the input port on your MIDI interface that is connected to the MIDI Out of your instrument.
6. From the Output pop-up menu, choose the output port on your MIDI interface that is connected to the MIDI In of your instrument.
7. Enable the appropriate MIDI channels (1–16) for the Send Channels and Receive Channels options (These determine which channels send and receive MIDI.)

Instrument Name

The Instrument Name field shows the user-definable instrument name for the currently selected instrument.

Manufacturer

The Manufacturer pop-up menu provides a list of MIDI equipment manufacturers. This list is derived from the XML-based MIDI device files.

💡 For more information, see “MIDI Patch Name Support” on page 77.
Model
The Model pop-up menu provides a list of MIDI devices, filtered by the manufacturer name. This list is derived from the XML-based MIDI device files provided with your Pro Tools installation.

For more information, see “MIDI Patch Name Support” on page 77.

Input Port
The Input Port pop-up menu displays a list of available MIDI interface input ports. The MIDI interface port that is set and displayed here is the port through which MIDI data is sent from the external MIDI device specified in the Instrument Name field into your MIDI interface.

If you set the input port to None, the defined instrument will not appear as a choice in a MIDI Input Selector.

Output Port
The Output Port pop-up menu displays a list of available MIDI interface output ports. The port set and displayed here is the port through which MIDI data is sent from your MIDI interface to the MIDI device specified in the Instrument Name field.

If you set the output port to None, the defined instrument will not appear as a choice in a MIDI Output Selector.

Send Channels
The Send Channels grid sets the send channels for the MIDI device specified in the Instrument Name field.

Receive Channels
The Receive Channels grid sets the receive channels for the MIDI device specified in the Instrument Name field.

MIDI Patch Name Support
Pro Tools supports XML (Extensible Markup Language) for storing and importing patch names for your external MIDI devices. Pro Tools installs MIDI patch name files (.midnam) for the factory default patch names of many common MIDI devices. These files reside in directories, sorted by manufacturer, in Program Files\Common Files\Digidesign\MIDI Patch Names\Digidesign.

To import MIDI patch names into Pro Tools:
1 Verify the MIDI Device name in the MIDI Studio Setup window (see “MIDI Studio Setup” on page 75).
2 Verify the MIDI track’s output is correctly assigned to the MIDI device.
3 Click the MIDI track’s Patch Select button.

Patch Select button, Edit window
Patch Select button, Mix window
4 In the Patch Select dialog, click the Change button.

5 In the Open dialog, navigate to Program Files\Common Files\Digidesign\MIDI Patch Names\Digidesign\<name of manufacturer>, and select the MIDI Patch Name file (.midnam) for the MIDI device.

6 Click Open.

The Patch Select dialog is populated with patch names and the Patch Name Bank pop-up menu appears in the upper left hand corner of the window.

To clear patch names:

- In the Patch Select dialog, click the Clear button, and click Done.

MIDI patch name files (.midnam) can be edited in any text editor, or you can use third-party patch librarian and editor software to create your own custom patch names.

Once patch names have been imported into Pro Tools, they are available for that MIDI device in all sessions.
appendix d

Configuring AMS (Mac OS X Only)

Audio MIDI Setup

Pro Tools recognizes the ports on your MIDI interface as generic ports. With Mac OS X, you use Apple’s Audio MIDI Setup (AMS) utility to identify external MIDI devices connected to your MIDI interface and configure your MIDI studio for use with Pro Tools.

⚠️ To ensure optimum performance, do not change the AMS configuration while Pro Tools is playing back. Stop the Pro Tools transport before launching AMS.

To configure your MIDI studio in AMS:

1. Do one of the following:
   - Launch Audio MIDI Setup (located in Applications/Utilities).
   - or –
   - In Pro Tools, choose Setup > MIDI > MIDI Studio.

2. Click the MIDI Devices tab. AMS scans your system for connected MIDI interfaces. If your MIDI interface is properly connected, it appears in the window with each of its ports numbered.

3. For any MIDI devices connected to the MIDI interface, click Add Device. A new external device icon with the default MIDI keyboard image will appear.

4. Drag the new device icon to a convenient location within the window.
5 Connect the MIDI device to the MIDI interface by clicking the arrow for the appropriate output port of the device and dragging a connection or “cable” to the input arrow of the corresponding port of the MIDI interface.

6 Click the arrow for the appropriate input port of the device and drag a cable to the output arrow of the corresponding port of the MIDI interface.

To remove a connection, select the cable and press Delete.

7 Repeat steps 3–6 for each MIDI device in your MIDI setup.

To configure an external MIDI device:

1. Select the external device icon and click Show Info (or double-click the new device icon).

2. Select a manufacturer and model for the new device from the corresponding pop-up menus. (If the Manufacturer and Model pop-up menus do not provide a name for your particular device, you can type a name.)

External Device Icon

Naming a new MIDI device
3 Click the More Information arrow to expand the dialog, then enable the appropriate MIDI channels (1–16) for the Transmits and Receives options. (These determine which channels the device will use to send and receive MIDI.)

4 Click the device image. The window expands to show images for various MIDI devices (such as keyboards, modules, interfaces, and mixers). Select an icon for your device.

5 Select a device image and click Apply.

6 Close the AMS window to quit the AMS application.

To use your own custom icons, you can place TIFF image files in /Library/Audio/MIDI Devices/Generic/Images, and they will appear as choices in the AMS device window.

To ensure optimum performance, do not launch the Pro Tools application while running AMS. Quit the Pro Tools application first, then launch Pro Tools.

The device names you enter appear as MIDI input and output choices in Pro Tools.
MIDI Patch Name Support

Pro Tools supports XML (Extensible Markup Language) for storing and importing patch names for your external MIDI devices. Pro Tools installs MIDI patch name files (.midnam) for the factory default patch names of many common MIDI devices. These files reside in directories, sorted by manufacturer, in /Library/Audio/MIDI Patch Names/Digidesign.

To import MIDI patch names into Pro Tools:
1. Verify the MIDI Device name in the Audio MIDI Setup window (see “Audio MIDI Setup” on page 79).
2. Verify the MIDI track’s output is correctly assigned to the MIDI device.
3. Click the MIDI track’s Patch Select button.

4. In the Patch Select dialog, click the Change button.

5. In the Open dialog, navigate to /Library/Audio/MIDI Patch Names/Digidesign/<name of manufacturer>, and select the MIDI Patch Name file (.midnam) for the MIDI device.

6. Click Open.

The Patch Select dialog is populated with patch names and the Patch Name Bank pop-up menu appears in the upper left hand corner of the window.

Once patch names have been imported into Pro Tools, they are available for that MIDI device in all sessions.

To clear patch names:
- In the Patch Select dialog, click the Clear button, and click Done.

MIDI patch name files (.midnam) can be edited in any text editor, or you can use third-party patch librarian and editor software to create your own custom patch names.
This appendix provides an overview of DSP-induced mixer delays, and explains how you can compensate for these delays to improve time and phase alignment of audio in complex or critical mixing situations.

- To learn about DSP-induced delays and when you should compensate, see “Introduction to DSP-Induced Delay” on page 83.
- To learn how to compensate for delays automatically with Delay Compensation (Pro Tools HD only), see “Automatically Compensating for Delays” on page 84.
- For details on the sources of DSP-induced delay, see “Delay Factors” on page 86.

**Introduction to DSP-Induced Delay**

In all digital systems, DSP processing causes signal delays of varying amounts. These DSP-induced delays can vary from as short as several microseconds to as long as several milliseconds, depending on the type of processing or routing being performed.

Do not confuse signal processing-induced delays with monitoring latency or time domain effects processing (such as delay, echo, reverb, and other desirable delay effects).

Each plug-in, hardware insert, and mixer assignment on a track delays that track by an amount equal to the total of all DSP-delay factors. (For more information on these delays, see “Delay Factors” on page 86.)

In some cases, signal processing delays matter only if you use a real-time TDM plug-in on one channel of a stereo or multichannel signal but not the others. This imparts an unequal amount of delay to the signals on that channel, which subsequently may cause undesirable cancellation of certain frequencies.

Audible symptoms of phase issues include comb-filtering and loss of high frequencies.

In simple terms, DSP-induced delay can cause audio to arrive at the main output (or a submix output) at different times. To maintain time alignment, you can compensate for DSP-induced delays.

**When to Compensate**

You may only really need to compensate for delays between tracks where phase coherency must be maintained (as with instruments recorded with multiple microphones or stereo pairs). If you are working with mono signals, and the accumulated delays are small (just a few samples, for example), you probably do not need to worry about compensating for delays.
However, larger sessions with higher track and voice counts, many plug-ins, and/or complex mixer routing can benefit when DSP-induced delays are compensated to maintain phase coherent time alignment.

In any session, if you want to maintain absolute time alignment across all tracks you should always compensate for signal processing delays.

Delay Compensation should be enabled during playback and mixing so that all tracks' outputs are correctly time-aligned.

When recording, Delay Compensation should usually be turned off (see “Low Latency Monitoring During Recording” on page 85).

**Automatically Compensating for Delays**

Pro Tools can automatically calculate and compensate for processing delays by using the Pro Tools Delay Compensation feature.

**Delay Compensation**

Pro Tools provides Delay Compensation for managing DSP delays from plug-in and hardware inserts, and mixer routing (bussing). With Delay Compensation enabled, Pro Tools maintains phase coherent time alignment between tracks that have plug-ins with differing DSP delays, tracks with different mixing paths, tracks that are split off and recombined within the mixer, and tracks with hardware inserts.

To maintain phase coherent time alignment, Delay Compensation should be enabled during playback and mixing.

To use Delay Compensation to compensate for DSP-induced delays:

1. Choose Setup > Playback Engine, and select a Delay Compensation setting (see “Delay Compensation Engine” on page 41).
2. Select View > Mix Window > Delay Compensation to display Delay Compensation indicators and fields for each track in the Mixer window.
3. Select Options > Delay Compensation to enable Delay Compensation.
4. Do any of the following, as needed:
   - Define specific delay values for hardware inserts (in the I/O Setup dialog)
   - Bypass Delay Compensation per track (in the Mixer window)
   - Fine-tune Delay Compensation for each track by entering a User Offset (in the Mixer window)

For more information on using Delay Compensation controls, see the Pro Tools Reference Guide.

To disable Delay Compensation on all tracks:

- Deselect Options > Delay Compensation.

**Channel Delay Indicator**

On all systems, the Channel Delay indicator (dly) in the Mix window displays the total delay, in samples, incurred on the track from the use of any plug-ins or hardware inserts on that channel.

For more information on delay indication when using Delay Compensation, see the Pro Tools Reference Guide.
To see the amount of processing delay on a track that uses plug-in or hardware inserts:

- In the Mix window, Control-click (Windows) or Command-click (Mac) the track’s Volume indicator to toggle between Volume (“vol”), Peak (“pk”) and Channel Delay (“dly”) indications.

**Delay that Exceeds the Compensation Limit**

When the total delay on a track exceeds the total available amount of Delay Compensation (selected in the Playback Engine dialog), no Delay Compensation is applied on that track. Any audio on that track will no longer be properly time-aligned and will be out of phase. Both the Delay indicator and Track Compensation indicator turn red to show that the track delay exceeds the Delay Compensation limit. The maximum available Delay Compensation is applied to all other tracks.

**To compensate for delay that exceeds the compensation limit, do one of the following:**

- If the Delay Compensation Engine setting in the Playback Engine is set to Short, change the setting to Long.
  - or –
- If the Delay Compensation Engine is already set to Long, do the following:
  - Bypass the reported delay for the track by Start-Control-clicking (Windows) or Command-Control-clicking (Mac) the Delay indicator. The track information is grayed out once it is bypassed.
  - and –
  - Manually nudge any audio data on the track earlier by the amount of delay reported in the track’s Delay indicator.

> For information on nudging tracks, see the Pro Tools Reference Guide.

**Low Latency Monitoring During Recording**

When an audio track is armed for recording (record-enabled), TrackInput-enabled, DestructivePunch-enabled, or punched in, the track’s Delay Compensation is automatically suspended (and the Track Compensation indicator displays 0). This provides low-latency monitoring on those track outputs.

Tracks that are not record enabled still apply Delay Compensation. Pro Tools automatically compensates for any timing discrepancies between the recorded material and the delay-compensated mix. When the track is played back (with both record-enable and TrackInput disabled) it is correctly time-aligned with the other delay-compensated tracks.

**Overriding Suspended Delay Compensation**

You can override the automatic suspension of Delay Compensation on record-enabled tracks, but you will introduce latency in the signal path by the amount of Delay Compensation. This latency may be acceptable depending on the recording source.

For example, if you are bus recording a mixdown, you will want to force-enable Delay Compensation on the record track. Or, if you are recording a source that does not need to monitor the session, you can force Delay Compensation on a track so that it is not automatically suspended for record-enabled, TrackInput-enabled, or DestructivePunch-enabled tracks.

**To apply Delay Compensation to tracks where Delay Compensation was suspended:**

- Start-Control-click (Windows) or Command-Control-click (Mac) the Track Compensation indicator. Track delay is applied to the track and the Track Compensation indicator displays in blue.
Delay Compensation on Auxiliary Inputs

Delay Compensation on Auxiliary Inputs can be bypassed to let you monitor outside sources (such as the audio tracks of a slaved video deck) with minimal latency, while still reporting the track’s delay.

To bypass an Auxiliary Input’s Delay Compensation:
- Start-Control-click (Windows) or Command-Control-click (Mac) the Track Compensation indicator. The reported track delay will be zero, and will appear grayed out.

Delay Factors

With Pro Tools HD, delay is incurred when you perform the following processes:
- Bouncing tracks. See “Bouncing Tracks” on page 86.
- Real-time processing with plug-in inserts. See “Using Plug-in Inserts” on page 86.
- Mixing and routing with sends. See “Using Sends” on page 87.
- Mixing and routing with hardware I/O (sends or inserts). “Using Hardware Inserts or Sends” on page 87.

Bouncing Tracks

Bouncing to tracks causes additional delay, as follows:

Bus-Based Bounces When you bus a track to another track and record the result, the following delays are incurred:

Bouncing to Disk The File > Bounce to > Disk command causes no delay on Pro Tools|HD systems, because Delay Compensation for the bounce function is built in. Because of this, Bounce to Disk may be more desirable than bus recording. For more information, see the Pro Tools Reference Guide.

Using Plug-in Inserts

Using plug-in inserts on a track causes additional delay.

For specific information on the delay amounts for DigiRack or Digidesign plug-ins, refer to your DigiRack Plug-ins Guide or Digidesign Plug-ins Guide.

With Delay Compensation enabled, Pro Tools can automatically compensate for delays due to plug-in inserts.
Using Sends

When you send a track to another track and return it to a track (audio, Auxiliary Input, or Master Fader), the following delays are incurred:

*Sends delays for Pro Tools|HD systems*

<table>
<thead>
<tr>
<th>HD Mixer</th>
<th>Sends</th>
<th>Delay</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stereo Mixer</td>
<td>Pre-fader send to bus</td>
<td>10 samples</td>
</tr>
<tr>
<td></td>
<td>Post-fader send to bus</td>
<td>8 samples</td>
</tr>
<tr>
<td>Surround Mixer</td>
<td>Pre-fader send to bus</td>
<td>8 samples</td>
</tr>
<tr>
<td></td>
<td>Post-fader send to bus</td>
<td>12 samples</td>
</tr>
</tbody>
</table>

Hardware sends also produce delays (see below).

With Delay Compensation enabled, Pro Tools automatically compensates for delays due to sends.

Using Hardware Inserts or Sends

When an audio interface is used on an insert or send, there is delay introduced by going through the D/A and A/D converter pair (for analog devices) or digital I/O connection (for digital devices) on the audio interface.

With Delay Compensation enabled, Pro Tools automatically compensates for these delays.

To compensate for the delay of any external hardware devices (such as an effects unit) that is used as a hardware insert in your session, you can set the amount of Delay Compensation (in milliseconds) for each external device. The controls for setting hardware insert delay are located in the I/O Setup dialog. See the Pro Tools Reference Guide for more information.
Benefits of TDM II

Digidesign’s TDM (or time division multiplexing) technology is based on the concept of a single, high-speed data highway, or bus that transmits data between your Pro Tools CPU, Pro Tools cards, and the DSP chips on the cards.

Pro Tools|HD cards feature Digidesign’s enhanced TDM II architecture. The TDM II architecture provides many advantages over the original TDM (or TDM I) architecture in terms of its mixing capacity and flexibility.

In TDM systems, individual channels from sources such as audio tracks, sends, or busses are sent out from Pro Tools audio cards, and combined together or multiplexed onto the TDM bus so that all signals can travel simultaneously and can be accessed within a single sample period. At the receiving end, the audio cards can listen to any connection on the bus, and take whatever data they need.

The TDM bus runs fast enough to accommodate many audio signals at the same time. Each separate audio signal or stream, takes up a single time slot on this multiplexed bus.

One of the most powerful features of the TDM architecture is that a single time slot can be used to “broadcast” data to many destinations simultaneously.

With TDM II, not only can it send data to many destinations simultaneously, but it can also send signals both bi-directionally and “privately” between DSP chips, which effectively provides a much greater number of available time slots. This provides a greater potential number of connections for routing, processing and mixing audio signals within Pro Tools.

TDM (or TDM I)
(Legacy Pro Tools MIX-Series Systems Only)

The TDM I architecture (used with Pro Tools|24 MIX systems) has a single bus where every DSP within the entire TDM system shares a single pool of 256 time slots. In practice, this means, for example, that if an audio track has a Reverb One plug-in insert, one of the 256 time slots is used to connect the Engine DSP on one chip to the Reverb One plug-in DSP on another chip. The TDM time slot used comes from the pool of 256 time slots, and is unavailable for use by the rest of the system.

Time slot usage on Pro Tools|24 MIX hardware
TDM II

With TDM II, there is a separate TDM I/O bus between each DSP chip on the Pro Tools cards, each with up to 512 bi-directional time slots at a session sample rate of 44.1 or 48 kHz (both between DSPs on each card, and between the DSPs that communicate between cards). The DSP chips are arranged serially, with a TDM I/O bus connecting one chip to the next. This means that every TDM II connection need only use time slots between the two DSPs that are being connected. See Figure 7 on page 90.

So, using the same example as above, if an audio track has a Reverb One plug-in insert, a time slot is used between the Engine DSP (sending out the audio track) and the DSP with the Reverb One instance. If the Reverb One insert is handled by a DSP that is physically next to the DSP handling mixing tasks, as shown in the illustration below, this leaves time slot 2 available for use between DSP 3 through DSP 9, and subsequent Pro Tools|HD cards.

Time slot usage on Pro Tools|HD hardware

The maximum consumption of the time slots for a single connection occurs when the audio must be sent between the first and last DSP in the system. In this instance, a time slot between each DSP is used to reach the last DSP in the chain.

Another example of how TDM II is more efficient than TDM I is to imagine a single HD Core card with one Engine chip and two Mixer chips. The DSPs with plug-in instances associated with the first Mixer do not need to communicate with the second Mixer, therefore the time slot numbers used can be re-used by the second Mixer to communicate with other DSPs loaded with other plug-ins.

Figure 7. TDM bus on Pro Tools|HD hardware
Appendix F: TDM Mixing and DSP Usage

DSP Allocation

Digital Signal Processing (or DSP) capability is one of the most powerful elements of your system. The DSP chips in your system provide the real-time processing power for your TDM Mixer and plug-ins. There is a limit, depending on your system, to how many functions a single DSP chip can power at once. This section contains some guidelines for getting the most from your available DSP capacity.

DSP Allocation Basics

As in the analog world, every send bus or output mix that you use demands that a summing mixer exist for that group. On an analog console, the number of these summing mixers is fixed by the physical layout of the console. In the Pro Tools mix environment, this number is variable, and depends on the number of output mixes or sends that you choose to create. Pro Tools allocates DSP power as it is needed to build the mixers for each session.

We describe certain mixing or signal processing functions as “using one DSP” or “using two DSPs.” This refers to the fact that there are 9 DSP chips on each HD card.

Each chip on a card can only power a certain number of processing functions. If you have a single Pro Tools|HD card, and you create a big enough TDM mixer and use enough sends or plug-ins, you will eventually use up or “max out” the DSP capacity of that card.

Mixing and DSP Usage

Pro Tools builds a TDM mixer every time a session is opened. Note that the term “mixer channel” applies to audio tracks (total voiceable tracks), Auxiliary Input tracks, and sends and returns that use any of the 128 internal busses. When you go beyond a certain number of mixer channels, Pro Tools will use another DSP to create additional mixer capacity.

Master Faders do not use additional DSP power.

DSP Manager

Pro Tools software includes the DSP Manager, a software component that optimizes the use of DSP capacity on Pro Tools|HD systems.

When you have an Pro Tools|HD card in your system, if your current DSP usage is approaching the capacity of the card, and you then try to add a mixer channel or assign a plug-in, the DSP Manager will automatically try to make room for the new mixer or plug-in on the Pro Tools|HD card. It does this by reallocating the existing TDM mixers and plug-ins to use the available DSP capacity on the Pro Tools|HD card as efficiently as possible.
Monitoring DSP Usage

The System Usage window provides a display of DSP usage. As you allocate DSP to mixing or processing with plug-ins, the System Usage window indicates when DSP chips are available and when they are in use. Green indicates a chip is free. Red indicates a chip is in use.

There are five different System Usage View formats: Small, Large, Detailed, Gas Gauge, and Activity Only. The Detailed and Gas Gauge formats show the percentage of each DSP chip in use.

With these indicators as your guide, you can try different mixer setups and different arrangements of plug-ins, sends, and Auxiliary Inputs to maximize your use of available DSP power.

💡 Another feature available for DSP management is Active and Inactive switching. See the Pro Tools Reference Guide for more information.

To monitor the usage of DSP resources during a Pro Tools session:

- Choose Window > System Usage.

To display DSP resources in different view formats:

- Choose View > System Usage, and one of the System Usage View formats (such as Small).
Setting up Sessions to Use DSP Efficiently

The dynamically configurable mixing environment in Pro Tools lets you make choices based on the type of setup you want to have—such as how many inputs you want for your mixer, how many plug-ins you want to use, or how many sends you need.

For example, you could allocate all of your DSP power to create a large mixer with dozens of channels—but you would not be able to use as many busses, sends, or TDM plug-ins. Alternatively, you could create a mixer with a smaller number of mixer channels plus some sends and Auxiliary Inputs for returns, and TDM plug-ins on several tracks.

DSP Usage and Mixer Plug-Ins

Understanding Mixers

Pro Tools|HD systems include two mixer plug-in “flavors”: stereo and surround (both of which are available with dither or without). Pro Tools uses these plug-ins to create “dynamic mixers,” meaning that the mixer size can expand or contract as mix channels are added or deleted in Pro Tools. More channels take up more DSP power from your Pro Tools hardware. This is different from hardware mixing consoles where hardware (analog or digital) creates “fixed” mix configurations consisting of an unchangeable number of master outputs, busses or sends.

DSP allocation for mixing in a Pro Tools|HD system is based on the concept of DSP summing mixers. Every send bus or output mix that you use requires that a summing mixer exists for those signals. Every single signal path that is mixed together requires the use of a mixer plug-in (whether a main output that goes to hardware, a bus or a send). This is even true for an individual signal that travels from hard disk to an individual hardware output. These individual dynamic mixers are created using the appropriate TDM mixer plug-in (stereo or surround) that is installed in your Plug-Ins folder.

An “input” can be an audio track, send, or internal bus connection. Adding an output or bus path (mono or multichannel) adds the requirement for DSP power to mix the signals together.

Each Pro Tools|HD card has nine DSPs, which can power a certain number of signal processing tasks. DSP resources are dynamically allocated as the number of mixers and inputs increases.

The TDM mixer provides basic building blocks by which applications such as Pro Tools can create a wide variety of mixer configurations.
Mono and Stereo

Each TDM mono or stereo mixer is of the dimensions “N x 2,” meaning that it mixes a variable number of inputs to an output pair. For example: A session with six tracks routed to Output 1–2 would require a single 6 x 2 mixer. If one of the six tracks is assigned to Output 3–4, however, two mixers are required—one 5x2 mixer routed to Output 1–2, and one 1x2 mixer routed to Output 3–4.

Multichannel Surround

Each Surround mixer can have a variable number of outputs as well as a variable number of inputs. For example, the 7.1 format requires eight outputs. A single mono track assigned to a 7.1 Output or Bus path would require a 1x8 mixer, while one mono and one stereo track assigned to a 7.1 Output or Bus path would require a 3x8 mixer.

The important concept here is that every output (whether they are I/O or bus outputs) requires that a mixer exists for that output. This means that creating a send to bus 1 requires that a mixer be created for the bus 1–2 outputs, and that mixer will have one input.

Mixing with Sends and Busses

Each send will add an input to the destination output pair. For example, a send to output 1 will add another input to the output 1–2 mixer. If the send destination doesn’t already have a mixer for its output pair, then a new mixer will be created. A send to bus 3 will make a 1x2 mixer for bus 3 if no other bus 3 sources have been created yet.

In addition, adding a new track and assigning its input to a bus source will create a mixer for that bus pair if there is not one already.

For example, creating a new Auxiliary Input track and setting its input to bus 5 will create a 1x2 mixer for bus 5, even if no sources have been created yet.

Submixing

When the number of channels that must be mixed exceeds the capacity of a single DSP, additional “main” mixers are created automatically, along with summing submixers (which sum together the “main” mixers). The use of submixers allows large mix configurations to be created.

For example, on a Pro Tools|HD system, when a Stereo mixer running at 44.1 kHz needs to grow to more than 68 inputs, a submixer is created along with another “main mixer” that provides “n” number of inputs beyond 68. Both the original 68x2 mixer and the new “N x 2” mixer which provides additional inputs are routed to a submixer, and its outputs are finally sent to the desired destination (such as Output 1–2 on your main audio interface).

Note that any small delays (on the order of a few samples) that are created remain equal between these main mixers because they are summed together by means of submixers, and are not cascaded.

The total number of voiceable tracks supported by your particular Pro Tools configuration will ultimately determine the maximum number of channels for your TDM mixer.

Mixers and DSP Hardware

Different mixer plug-ins are available, each of which uses DSP power at slightly different rates on the different audio cards (and their DSP chips), as shown in the following tables.

See “Mixer Plug-ins” on page 97.
In Pro Tools|HD systems, the number of available mixers per DSP chip is based on the type of card and session sample rate.

**HD Accel (for PCI or PCIe) card, Standard mixers**

<table>
<thead>
<tr>
<th>Mixer</th>
<th>Sample Rate (kHz)</th>
<th>Usage per Chip</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stereo</td>
<td>44.1 and 48</td>
<td>124x2</td>
</tr>
<tr>
<td></td>
<td>88.2 and 96</td>
<td>54x2</td>
</tr>
<tr>
<td></td>
<td>176.4 and 192</td>
<td>16x2</td>
</tr>
<tr>
<td>Surround, 5.1</td>
<td>44.1 and 48</td>
<td>46x6</td>
</tr>
<tr>
<td></td>
<td>88.2 and 96</td>
<td>34x6</td>
</tr>
<tr>
<td></td>
<td>176.4 and 192</td>
<td>8x6</td>
</tr>
<tr>
<td>Surround, 7.1</td>
<td>44.1 and 48</td>
<td>34x8</td>
</tr>
<tr>
<td></td>
<td>88.2 and 96</td>
<td>25x8</td>
</tr>
<tr>
<td></td>
<td>176.4 and 192</td>
<td>4x8</td>
</tr>
</tbody>
</table>

**HD Accel card (for PCI or PCIe), Dithered mixers**

<table>
<thead>
<tr>
<th>Mixer</th>
<th>Sample Rate (kHz)</th>
<th>Usage per Chip</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stereo Dithered</td>
<td>44.1 and 48</td>
<td>113x2</td>
</tr>
<tr>
<td></td>
<td>88.2 and 96</td>
<td>54x2</td>
</tr>
<tr>
<td></td>
<td>176.4 and 192</td>
<td>16x2</td>
</tr>
<tr>
<td>Surround Dithered, 5.1</td>
<td>44.1 and 48</td>
<td>44x6</td>
</tr>
<tr>
<td></td>
<td>88.2 and 96</td>
<td>27x6</td>
</tr>
<tr>
<td></td>
<td>176.4 and 192</td>
<td>8x6</td>
</tr>
<tr>
<td>Surround Dithered, 7.1</td>
<td>44.1 and 48</td>
<td>34x8</td>
</tr>
<tr>
<td></td>
<td>88.2 and 96</td>
<td>20x8</td>
</tr>
<tr>
<td></td>
<td>176.4 and 192</td>
<td>4x8</td>
</tr>
</tbody>
</table>

**HD card (for PCI), default Standard mixers**

<table>
<thead>
<tr>
<th>Mixer</th>
<th>Sample Rate (kHz)</th>
<th>Usage per Chip</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stereo</td>
<td>44.1, 48</td>
<td>68x2</td>
</tr>
<tr>
<td></td>
<td>88.2, 96</td>
<td>44x2</td>
</tr>
<tr>
<td></td>
<td>176.4, 192</td>
<td>16x2</td>
</tr>
<tr>
<td>Surround, 5.1</td>
<td>44.1, 48</td>
<td>22x6</td>
</tr>
<tr>
<td></td>
<td>88.2, 96</td>
<td>12x6</td>
</tr>
<tr>
<td></td>
<td>176.4, 192</td>
<td>4x6</td>
</tr>
<tr>
<td>Surround, 7.1</td>
<td>44.1, 48</td>
<td>16x8</td>
</tr>
<tr>
<td></td>
<td>88.2, 96</td>
<td>8x8</td>
</tr>
<tr>
<td></td>
<td>176.4, 192</td>
<td>2x8</td>
</tr>
</tbody>
</table>

**HD card (for PCI), Dithered mixers**

<table>
<thead>
<tr>
<th>Mixer</th>
<th>Sample Rate (kHz)</th>
<th>Usage per Chip</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stereo Dithered</td>
<td>44.1, 48</td>
<td>56x2</td>
</tr>
<tr>
<td></td>
<td>88.2, 96</td>
<td>34x2</td>
</tr>
<tr>
<td></td>
<td>176.4, 192</td>
<td>14x2</td>
</tr>
<tr>
<td>Surround Dithered, 5.1</td>
<td>44.1, 48</td>
<td>19x6</td>
</tr>
<tr>
<td></td>
<td>88.2, 96</td>
<td>10x6</td>
</tr>
<tr>
<td></td>
<td>176.4, 192</td>
<td>1x6</td>
</tr>
<tr>
<td>Surround Dithered, 7.1</td>
<td>44.1, 48</td>
<td>15x8</td>
</tr>
<tr>
<td></td>
<td>88.2, 96</td>
<td>7x8</td>
</tr>
<tr>
<td></td>
<td>176.4, 192</td>
<td>not supported</td>
</tr>
</tbody>
</table>
48-Bit Mixing Precision

The Pro Tools mixer plug-ins use a register area inside of the DSPs on the hardware to hold a full 48-bits of precision when mixing signals together. This allows a fader to be lowered in level without any loss of resolution. (Even if the fader is lowered almost to the bottom, all 24 of the original 24 bits of the signal are preserved.)

Mixer Headroom

Use of 48-bit precision when mixing allows the mixer to be designed to provide a very large amount of headroom, which allows the faders on the Pro Tools mixer to be placed in the “sweet spot” position without clipping.

Mixer plug-ins provided with Pro Tools|HD systems provide 48-bit precision with 48 dB of headroom. This means that on the “input” side of the bus (where signals are summed together), signals can never clip (even if channel faders are set to a full +12 dB of gain).

However, the “output” side of the summing mixer (where the signal is sent in the 24-bit world of a digital output or onto the TDM bus) can clip. You can use a Master fader (which does not “cost” any DSP) to scale the output level of any mix summing point (a bus or physical output). The master fader’s meters will tell you if you are clipping the mix bus, and the fader can be used to safely scale the level to avoid clipping, with no loss of quality.

Note that clipping the “input” side of a mixer is not a concern on Pro Tools|HD systems. It is virtually impossible to clip the input of any Pro Tools|HD mixer plug-in, because the 48 dB of headroom provided prevents any possibility of overload, even with a maximum number of inputs being fed by full-code signals with fader gains at maximum. While it is possible to clip the “output” side of the mixer, you can safely use a Master Fader to trim your mix bus back to avoid clipping (by simply examining the Master Fader meter for clipping, and pulling back the fader until it disappears; make sure that any plug-ins you may have on the Master Fader inserts are not the cause as well). The 48-bit precision of the mixer allows gain adjustment on the Master Fader with no loss of data integrity or audio quality, so there is no need to trim the individual input faders back to avoid clipping.

Mixer Automation

Volume automation on all mixer versions is near sample-accurate (as is pan automation on the stereo versions). In addition, DAE provides 24-bit interpolated values between mix breakpoints, which provides near “analog-like” resolution. This process of interpolation means that a smooth “data series” is created between any two breakpoints that you specify in Pro Tools. DAE calculates these smooth transitions on the DSP hardware with 24-bit precision, which provides extremely smooth volume changes. In addition, DAE “de-zippers” any “live input” to the mixer so that fast, real-time fader changes that come in from fader movements (on the Pro Tool user interface or control surfaces), do not cause audible artifacts as the mixer tries to “catch up” to fast changes that it receives.

If you are mixing larger numbers of signals together, always use a master fader so that you can monitor levels for the bus (using the master fader meter), and to trim the result to avoid clipping. Since Master faders cost no DSP, there is no reason not to use them.
Stereo and Surround Dithered Mixers

The Stereo Dithered and Surround Dithered mixer plug-ins provide non-correlated dither in addition to other basic attributes of the mixers described above. Every output summing point (whether to an internal bus or an physical output) is dithered in these mixers. This technique is used to avoid any possibility of audible artifacts caused by truncation of extremely low level data that occurs when signals pass from the 48-bit world of a TDM mixer to the 24-bit world of a TDM bus connection or a hardware output. Any material that is truncated, lies below –144 dBFS (reflecting 24-bit of dynamic range).

There is dissension in the audio community as to whether or not artifacts that fall within this area are actually audible in some way. (The normal dynamic range of human hearing is generally accepted to fall within a range of around 120 dB, from the threshold of audibility to the threshold of pain.)

Digidesign has developed a mixer that provides all of the benefits of the standard stereo and surround mixer plug-ins, but also provide uncorrelated dither on any summed output. This provides a steady dither “noise floor” at extremely low level, which causes any truncation artifacts to be converted into steady white noise. However, the addition of uncorrelated dither requires more DSP horsepower. As a result, the channel instance count from the dithered versions of the mixers is around 15% lower (or more) than the non-dithered standard versions (this varies with sample rate and mixer type).

For this reason, we offer both types of mixer plug-in. You may want to use the standard non-dithered mixer in most applications because of its greater efficiency (allowing you to mix more channels without running out of DSP power), or the dithered mixer because of its theoretical advantages.

A Note About Dithering to 16-Bit and Dither Plug-ins

The Dithered mixers provide 24-bit dither at their summing points. When creating a final mix that results to 16-bits (for example, for CD mastering), final dithering should still be handled by plug-ins that provide dither. To properly dither the final mix result, insert a dither plug-in on the post-fader inserts of a Master fader. Details about dither and proper usage of the dither plug-ins can be found in the Pro Tools Reference Guide.

Mixer Plug-ins

Pro Tools|HD systems come with four different mixers: Stereo, Surround, Stereo Dithered, and Surround Dithered.

The standard Stereo and Surround Mixer plug-ins are installed by default. When you run your Pro Tools Installer, a copy of the Stereo Dithered and Surround Dithered mixers are placed in the folder “Plug-ins (Unused).”
Plug-in Features

Standard Surround and Stereo Mixers

Both the Surround and Stereo Mixer plug-ins provide the following:
- 24-bit digital output, from an audio interface output or Bounce to Disk. Mix level scaling stores 48-bit results, using a 56-bit accumulator for maximum precision.
- 48 dB of mix headroom.
- Output clip indication.
- Multichannel mixing formats for surround (Surround Mixer only).

Surround Dithered and Stereo Dithered Mixers

Both the Surround Dithered and Stereo Dithered Mixer plug-ins provide the following:
- The same features as the standard Pro Tools|HD Stereo and Surround mixers, with the addition of non-correlated dither to any output or bus send.

⚠️ When using Dolby Digital encoders or Dolby E, you can only use the non-dithered mixer. The Dithered mixer will not allow proper playout of Dolby Digital or Dolby E out of an output.

Switching Mixer Plug-ins

To switch TDM Mixer plug-ins:

1. Quit Pro Tools.
2. Do one of the following:
   - On Windows systems, open the “Plug-ins (Unused)” folder (Program Files\Common Files\Digidesign\DAE).
   - or –
   - On Mac systems, open the “Plug-ins (Unused)” folder on your Startup drive (Library/Application Support/Digidesign).
3. Locate the Mixer plug-in that you want to use, and drag it to the Plug-ins folder.
4. Open the “Plug-ins” folder, locate the Mixer plug-in version that you no longer want to use, and drag it to the “Plug-ins (Unused)” folder.
5. Launch Pro Tools.

Mixer Usage Guidelines

The following conditions apply to mixing with Pro Tools|HD systems.
- One DSP chip is automatically dedicated to mixing in the TDM environment.
- As you reach the basic mixer limits for a single DSP chip, the system will automatically begin allocating DSP resources from another chip (if available), making it unavailable for plug-ins.
- Each bus or send connection requires DSP to mix signals. This means that each send or Auxiliary Input that you create will require DSP power to mix the results.
DSP Usage with TDM Plug-Ins

To get the best results when using TDM plug-ins, keep in mind the following guidelines:

- Pro Tools|HD systems use Digidesign’s MultiShell™ technology, that lets any MultiShell compatible plug-in share DSP chips HD cards. Up to five types of MultiShell compatible plug-ins can share a single DSP chip.

  Refer to the DigiRack Plug-Ins Guide for details on MultiShell plug-ins.

- Stereo DSP plug-ins generally use up twice as much DSP as mono plug-ins.

- Master Faders do not require additional DSP. Use them freely to control submix levels, send/bus output levels, and the master output level of your session.

The session templates provided with your system include several useful preconfigured session setups that make efficient use of DSP resources.

If your computer has unused slots, you can always increase your available DSP resources by adding additional HD cards to your Pro Tools|HD system.
Appendix G: Troubleshooting

Backing Up Your Work

It is highly recommended that you back up your work on a regular basis, and especially before making changes to your system configuration.

Backing Up Your Session Data

Back up your session and audio data frequently. There are a variety of media that are suited to back up projects of various sizes, from automated tape backup systems to high-capacity optical drives, to CD/DVD burners.

The best way to back up an entire session is to use the Save Copy In command. This command lets you save the session file and all of its associated files to a new location.

💡 You can also use the Auto Save Backup feature (in the Operation Preferences page) to have Pro Tools automatically save backups of the session file while you work.

Backing Up Your System Configuration

After configuring your system and Pro Tools, you should save an image of your system drive using a backup utility such as Norton Ghost (Windows) or Bombich Carbon Copy Cloner (Mac). By doing this, you can quickly restore your system configuration and settings if you encounter any problems.
Common Issues

Pro Tools Won’t Launch

**Problem**
When you double-click the Pro Tools application or a Pro Tools session file, Pro Tools doesn’t launch, or displays an error message.

**Possible Solutions**
- Check to be sure your computer has the required amount of RAM to launch Pro Tools. Refer to the Digidesign website (www.digidesign.com).
- Try a complete restart. Turn off your audio interfaces, computer peripherals and your computer, and then turn them on again in the proper sequence.
- If you tried to launch Pro Tools by double-clicking a Pro Tools session file, do the following:
  - Close any error message.
  - Double-click the Pro Tools application.
  - In Pro Tools, choose **File > Open Session** to open the session.
- Reinstall the Pro Tools application, using the Pro Tools Installer disc.

Audio Interface Is Not Recognized

**Problem**
When you launch Pro Tools it does not recognize an audio interface, or a connected audio interface is not available.

**Possible Solutions**
- Turn off your computer and check to be sure your cables are properly and securely connected to your computer and to your audio interface.
- Verify that your Hardware Setup dialog settings are correct.
- If you only have one interface, make sure it is connected to the Accel Core (for PCIe) or HD Core (for PCI) card.
- Make sure Loop Sync, SuperClock or other synchronization connections to your audio interface are correct. Disconnect the clock source from the interface and see if the problem persists.

Using DigiTest as a Diagnostic Tool

The DigiTest utility performs diagnostic tests on the Pro Tools cards in your system. If DigiTest reports that any of your cards have failed, click the Info button next to that card. Write down the information that appears and report it to your local Digidesign dealer or to Digidesign Technical Support.
Performance Factors

There are several conditions that may adversely affect the performance of Pro Tools. These include:

Network Connections Close any network connections unless you are using them for network interchange of audio data.

Background Applications Any software utilities that run in the background or generate disk activity, such as virus protection, disk optimization, or file savers, should be turned off or removed.

Screen Savers Screen saver software should be completely disabled on your computer before running Pro Tools.

Power Saver Features Some automatic power saver features, such as those that spin down the system hard drive, can affect Pro Tools performance. These features should be turned off.

Before You Call Digidesign Technical Support

Register Your System

Register your purchase immediately after reviewing the Digidesign Registration Information Card included with every Pro Tools system. Registering your purchase is the only way you become eligible to receive complimentary technical support and future upgrade offers. Registering is one of the most important steps to complete as a new user.

Use Digidesign Resources

In addition to the printed and PDF versions of Pro Tools guides, your system includes the following sources of information:

Read Me Files These contain late-breaking information and known issues pertaining to Pro Tools software and hardware configurations. Read Me files are installed in the Documentation folder when you install Pro Tools.

Answerbase This is a database of common problems and DAE errors, and their solutions based on the latest information from Digidesign Technical Support. This database is installed in the Digidesign folder when you install Pro Tools. The Answerbase is also available on the Digidesign website (www.digidesign.com).

Website (www.digidesign.com) This is your best online source for information to help you get the most out of your Pro Tools system.
Gather Important Information

Digidesign wants to help you resolve problems as quickly and efficiently as possible. If you have the following information handy when you contact Technical Support, it will make the diagnosis of your problem easier. Take a few minutes to collect the following basic information:

System Information

Computer
- Make, model, processor speed
- Amount of system RAM
- Operating system (version of Windows or Mac OS)
- Any Drivers, Disk Utilities, or other system-related applications you may have installed

Digidesign Hardware
- Type of cards, interfaces, or peripherals
- Where the cards are installed
- PCI or PCIe card order in computer or chassis
- Interfaces connected to each card

Hard Drives
- Make, Model
- Drive size (GB)
- Drive speed (RPM)
- Drive type (SCSI, FireWire, IDE/ATA)
- Utility used to format the drive
- Number and size of partitions on the drive

Digidesign Software
- Pro Tools software version
- Plug-in versions
- Other Digidesign software
- Additional plug-ins from Digidesign Development Partners

Other Hardware

Refer to the manufacturer’s documentation for operational details.

The most common hardware additions include:
- SCSI host bus adapter (HBA) cards (manufacturer, model, settings)
- 1394 (FireWire) cards for Windows systems (manufacturer, model)
- Expansion Chassis (manufacturer, model, bridge chip type)
- Video Capture cards (manufacturer, model)

To verify that your hardware is qualified for use with your Pro Tools system, refer to the Digidesign website (www.digidesign.com).

Other Software

If you are using other audio or video applications, refer to the manufacturer’s documentation for operational details.

Make note of any other software that was running when a problem occurred.

Diagnostic Information

DigiTest

If you run DigiTest, be sure to make a note of any error codes or messages it generates.

Other Information

Note any DAE errors or other error codes you encounter. Additionally, note the ability to reproduce the problem under different conditions, for example, with another session, or after changing settings (such as the Hardware Buffer Size).
Numerics
1622 I/O 7
16-channel peripheral cable adapter 16, 27
192 Digital I/O 6, 48, 60
192 I/O 6, 48, 60
24-bit ADAT Bridge I/O 7
882|20 I/O 7
888|24 I/O 7
96 I/O 7, 49, 60
96i I/O 7, 49, 60

A
Accel Core (for PCIe) 3
ADAT Bridge I/O 7
allocating DSP 91, 93
ASIO driver (Windows) 19
audio
connections 61
audio drivers
ASIO driver (Windows) 19
CoreAudio driver (Mac) 29
WaveDriver (Windows) 19
audio interfaces
connection 14
firmware (Windows) 36
HD 6
heat and ventilation 14, 25
Legacy 7
Audio MIDI Setup (AMS) (Mac) 79
authorizing Pro Tools HD 18, 29
automatic delay compensation 41
Auxiliary Inputs
and DSP usage 98

C
Cache Size 42
Channel Delay indicator 84
ClearType font smoothing (Windows), disabling 53
Clock Source 45
connecting
digital recorders 60
eexternal SCSI drive 66
Pro Tools cards 13, 24
SMPTE synchronization devices 62
CoreAudio driver (Mac) 29
CPU Usage Limit 38

D
DAE Playback Buffer Size 42
Dashboard shortcut (Mac), disabling 56
DAT recorder
connecting
digital recorders 60
external SCSI drive 66
Pro Tools cards 13, 24
SMPTE synchronization devices 62
DigiSerial port 3, 4
digital signal processing (see DSP)
DigiTest 34
troubleshooting 35
DMA option (Windows), enabling 53
drive formatting
Mac 71
Windows 70, 71
drive maintenance 69
drive requirements 8
DSP 91
- allocating 91, 93
- and Auxiliary Inputs 98
- and Master Faders 99
- and mixing 91
- and TDM plug-ins 99
- monitoring usage 92

DSP delays 83
- automatic compensation 41

DSP Manager 91

E
- Energy Saver (Mac), turning off 56
- error codes
  - DigiTest 35
- Ext. Clock Output 46

F
- FireWire requirements 70
- firmware
  - audio interfaces (Windows) 36

H
- hard drives
  - drive formats 69
  - FireWire requirements 70
  - formatting 70, 71
  - formatting (Mac) 71
  - IDE/ATA requirements 70
  - maintenance 69, 72
  - optimizing 73
  - partitioning 72
  - requirements 8
  - SCSI requirements 69
  - space requirements 74
- Hardware Buffer Size 37
- Hardware Setup
  - Ext. Clock Output 46
  - Meters pop-up menu for 96 I/O 47
- HD Accel 5
- HD Accel (for PCIe) 4
- HD Core card 4

I
- I/O Setup 51
- IDE/ATA requirements 70
- installing Pro Tools 17, 28
- installing Pro Tools|HD cards 12, 22
- installing QuickTime (Windows) 18

J
- journaling (Mac), enabling 56

L
- Legacy I/Os 50

M
- Master Faders
  - and DSP usage 99
- MIDI
  - connections 62
  - setup (Mac) 79
  - setup (Windows) 75
- MIDI Studio Setup (MSS) (Windows) 75
- Mixer plug-ins 97
- mixing
  - and Delay Compensation 41
  - and DSP usage 91
- MultiShell 99

N
- network cards (Windows), disabling 54
- Number of Voices setting 40

O
- optimizing hard drives 73

P
- partitioning hard drives 72
- Peripherals list 46
- playback engine
  - RTAS Processors setting 38
- Plug-in Streaming Buffer 44
- Plug-in Streaming Buffer Size 43
plug-ins
   RTAS Processors setting 38
power
   management settings (Windows) 53
Preferences 28
Pro Tools
   authorizing 18, 29
   capabilities 2
   configuration 37
   demo session (Windows) 20, 30
   installing 17, 28
   launching 18, 29
   preferences 18
   removing (Mac) 31
   removing (Windows) 20
   session templates (Windows) 20, 30
Pro Tools software installation
   Mac 28
   Windows 17
Pro Tools|HD cards
   installing 12, 22
processor performance (Mac) 56
Processor Scheduling performance (Windows) 54
Program Change dialog 78, 82

S
   sample delays (see DSP delays)
Sample Rate 41, 44
screen savers 103
SCSI
   cable length 66
   requirements 65
   termination 67
SCSI drives
   connecting 66
SCSI requirements 69
Software Update (Mac), turning off 55
Spotlight indexing (Mac), disabling 56
Spotlight shortcuts (Mac), disabling 56
Startup items (Windows), disabling 55
Stereo Mixer plug-in 98
studio setup
   with a mixer 58
   without a mixer 59
Surround Mixer 97, 98
SYNC I/O 3, 4, 62
system
   optimization (Mac) 55
   optional optimizations (Windows) 54
   recommended optimizations (Windows) 54
   required optimizations (Windows) 52
   shutting down 33
   starting up 33
System Memory Allocation 43
system optimization
   Windows 54
system settings
   Cache Size 42
   Clock Source 45
   CPU Usage Limit 38
   Hardware Buffer Size 37
   I/O Setup 51
   Number of Voices 40
   Plug-in Streaming Buffer 44
   Plug-in Streaming Buffer Size 43
   RTAS Engine 39
   Sample Rate 41, 44
   System Memory Allocation 43
   System Usage window 92

Q
   QuickTime
      installing (Windows) 18

R
   recording
      and Delay Compensation 41
   registration information 9
   removing Pro Tools
      Mac 31
      Windows 20
   routing
      digital effects 62
   RTAS Engine 39
   RTAS error suppression 39
   RTAS Processors setting 38
T
TDM FlexCable 5
TDM Mixer plug-ins 98
TDM plug-ins
  and DSP usage 99
  MultiShell 99
termination of SCSI drives 67
time alignment 83

U
uninstalling Pro Tools
  Mac 31
  Windows 20

W
WaveDriver (Windows) 19
Window menu
  System Usage window 92
Word Clock 46